Legal Notes

Unauthorized reproduction of all or part of this guide is prohibited.
The information in this guide is subject to change for improvement without notice.
We cannot be held liable for any problems arising from the use of this product, regardless of the information herein.

Regarding Trademarks

• PCL is a registered trademark of Hewlett-Packard Company.
• Microsoft Windows is a registered trademark of Microsoft Corporation in the U.S. and/or other countries.
• PostScript is either a registered trademark or trademark of Adobe Systems Incorporated in the U.S. and/or other countries.
• TrueType is a registered trademark of Apple Computer Inc.
• All other brand and product names herein are registered trademarks or trademarks of their respective companies.

Examples of the operations given in this guide support the Microsoft Windows XP printing environment. Essentially the same operations are used for Microsoft Windows 2000/Vista environments.

Models supported by the KX printer driver

| FS-820   | KM-C2520 | FS-C8008N | CS-1820 |
| FS-920   | KM-C3225 | FS-C8026N | CS-2560 |
| FS-1118MFP | KM-C3232 | FS-9100DN | CS-3050 |
| FS-1030D | KM-C4008 | FS-9120DN | CS-3060 |
| FS-2000D | KM-C4035E| FS-9500DN | CS-4050 |
| FS-3900DN| KM-C3232E| FS-9520DN | CS-5050 |
| FS-4000DN| KM-C3225E| KM-1530   | CS-6030 |
| FS-6850DN| KM-C2525E| KM-1650   | CS-8030 |
| FS-9130DN| FS-1010  | KM-1815   | CS-C2520|
| FS-9530DN| FS-1018MFP| KM-2030  | CS-C3225|
| FS-C5015N| FS-1020D | KM-2050   | CS-C3232|
| FS-C5020N| FS-1050  | KM-2530   | CS-C4008|
| FS-C5025N| FS-1100* | KM-2550   | CS-C4035E|
| FS-C5030N| FS-1300D*| KM-3035   | CS-C3232E|
| FS-C8100DN| FS-1800  | KM-3530   | CS-C3225E|
| KM-1820  | FS-1800+ | KM-4030   | CS-C2525E|
| KM-2540* | FS-1900  | KM-4035   | CS-1650 |
| KM-2560* | FS-1920  | KM-4530   | CS-2050 |
| KM-3040* | FS-3800  | KM-5035   | CS-2550 |
| KM-3050* | FS-3800KPDL3| KM-5530 | EP 370DN*|
| KM-3060* | FS-3820N | KM-6330   | EP 470DN*|
| KM-4050* | FS-3830N | KM-7530   | EP 510DN*|
| KM-5050* | FS-C5016N| KM-C830   | EP C170N*|
| KM-6030  | FS-6020  | KM-C850   | EP C220N*|
| KM-8030  | FS-6026  | KM-C2630  | EP 270N* |
|          |          |           | EP 320DN*|

*Not supported in Windows 95/98/Me or Windows NT.
The explanatory screens shown in this guide may differ from your printing system.
# Table of Contents

## Chapter 1  Installation

- Express Installation ........................................... 1-2
  - Windows XP and Vista - Express Installation .................. 1-2
- Custom Installation ............................................ 1-2
  - Vista - Custom Installation ................................. 1-3
  - Windows XP - USB, Custom ................................ 1-3
  - Windows XP - Parallel Port (LPT) .......................... 1-4
  - Windows XP - Network Connection, Custom .................. 1-4
- Installing Optional Components ................................ 1-5
- Product Library CD ............................................ 1-6
- Installing using the Add Printer Wizard ....................... 1-6

## Chapter 2  Printer Properties

- Accessing Printer Properties ................................... 2-1
- Installing Optional Devices .................................... 2-1
  - Auto Configure ............................................... 2-1
  - Device Options ............................................... 2-2
  - Punch Unit Settings ......................................... 2-3
  - Assigning Custom Boxes ..................................... 2-4
- User Settings .................................................... 2-4
  - Identification ................................................ 2-4
  - Unit of Measurement ......................................... 2-4
  - Language Preference Selection ............................... 2-5
- Page Description Language (PDL) .............................. 2-5
  - PDL Settings ................................................ 2-5
- Administrator Settings .......................................... 2-9
  - User Login .................................................. 2-9
  - Job Accounting ............................................. 2-11
  - Administrator Password ..................................... 2-12
- Compatibility Settings .......................................... 2-12

## Chapter 3  Printing Basics

- Basic Printing Tasks ........................................... 3-1
  - Basic Printing .............................................. 3-1
- Printing on Paper of Non-Standard Sizes ....................... 3-4
  - Custom Paper Sizes ......................................... 3-5
- Duplex Printing ................................................ 3-6
  - Print on Both Sides .......................................... 3-6
- Reverse Order Printing ......................................... 3-7
- Collating Modes ............................................... 3-8
  - Sorter Modes ............................................... 3-9
### Chapter 4 Layout

- Booklet ................................................. 4-1
- Left Edge and Right Edge Binding .......... 4-1
- Booklet Printing ................................. 4-2
- Multiple Pages Per Sheet ....................... 4-3
- Poster .................................................. 4-3
- Sheets Per Page ..................................... 4-4
- Available Poster Sizes ......................... 4-4
- Scaling ............................................... 4-6
- Scaling ............................................... 4-6

### Chapter 5 Finishing

- Finishing Edge .................................... 5-1
- Gutter ............................................... 5-4
- Staple ............................................... 5-4
- Using the Stapler .................................. 5-5
- Punch ............................................... 5-6
- Using Hole Punch .................................. 5-6
- Separation ......................................... 5-7
- Rotate Copies ...................................... 5-7
- Offset Jobs ......................................... 5-7

### Chapter 6 Imaging

- Print Quality ....................................... 6-1
- Custom Print Quality Settings ............... 6-2
- EcoPrint ............................................. 6-2
- Fonts ............................................... 6-2
- Font Substitution .................................. 6-4
- Disable Device Fonts ......................... 6-4
- Graphics ........................................... 6-4
- Pattern Scaling .................................... 6-5
- Inversion Options ................................. 6-5
- Optimization ....................................... 6-5
- Halftone Screen ................................... 6-6
- Grayscale .......................................... 6-7

### Chapter 7 Publishing

- Printing with Covers ............................. 7-1
- Cover Printing Options ......................... 7-2
- Edit Cover Printing Options ................... 7-4
- Page Insert ......................................... 7-4
- Insert Page Printing ............................. 7-5
- Combinations ....................................... 7-6
- Transparency Interleaving .................... 7-6

### Chapter 8 Job

- Job Storage (e-MPS) ............................... 8-1
- Custom Box ......................................... 8-2
- Quick Copy ......................................... 8-7
- Proof and Hold ..................................... 8-8
### Chapter 9 Advanced

- Prologue/Epilogue .......................................................... 9-1
  - Select Prologue/Epilogue File to Insert ......................... 9-2
  - Add ............................................................................. 9-2
  - Edit ............................................................................. 9-2
  - Delete .......................................................................... 9-2
  - Insertion Point ............................................................. 9-3
- Watermark ................................................................. 9-4
  - Select Watermark .......................................................... 9-4
  - Page selection ............................................................... 9-4
  - Add Watermark ............................................................ 9-5
  - Additional Text Options .................................................. 9-5
  - Edit Watermark ............................................................. 9-7
  - Delete Watermark .......................................................... 9-7
- Security Watermark ...................................................... 9-7
  - Select Security Watermark ................................................ 9-9
  - Page Selection ............................................................... 9-9
  - Add Security Watermark ................................................... 9-10
  - Additional Options ........................................................ 9-11
  - Edit Security Watermark ................................................... 9-13
  - Delete Security Watermark ............................................... 9-14
- Security Settings ......................................................... 9-14
  - Security Watermark in Security Settings ......................... 9-14
- PrintID Tracker ............................................................. 9-14
  - Lock PrintID Tracker ..................................................... 9-16
- Enable Client Profile ...................................................... 9-17
- EMF Spooling ............................................................... 9-18

### Chapter 10 Profile

- Add Profile ................................................................. 10-1
- Edit Profile ................................................................. 10-2
- Delete Profile ............................................................... 10-3
- Import and Export Profile .................................................. 10-3

### Glossary

### Index
1 Installation

A printer driver is an application that sends documents to a printer and manages communication between a printer and your computer. Install the printer driver from the supplied Product Library CD-ROM. Once installed, a variety of printer settings can be configured.

**Note:** In Windows XP, Windows Vista, and Windows 2000, you must be logged in with administrator rights to install the KX Driver. If you connect the Universal Serial Bus (USB) cable before CD installation, it is strongly recommended that you cancel the Found New Hardware Wizard and install the software through the CD menu. Browsing the CD and installing each driver separately is not recommended.

1. Turn off the power for the computer and printer.

2. Ensure that the printer is ready to print (remove packing materials, insert paper and any toner or ink cartridges), then connect the computer and printer using either USB, a parallel cable, or a network cable. For further details on connecting the printer to the computer, refer to the printer’s Operation Guide.

3. Once connected, power on both devices.

   If the Windows Found New Hardware Wizard appears, click Cancel.

4. Insert the Product Library CD-ROM into the CD drive.

   After the installation program starts the Main Menu appears.

   **Note:** If the Product Library Software Installation Wizard fails to start after inserting the CD-ROM into the CD drive, explore the CD drive, and double-click Setup.exe.

5. Click View License Agreement to read the License Agreement.

6. Click Accept to proceed.

7. To begin installation, click Install Software.

8. The Software Installation Wizard appears. Click Next.

   The installation differs depending on your operating system and connection method. Select your operating system and connection method from the list below and proceed to the referenced page to continue the installation.

   - Windows XP and Vista - Express Installation on page 1-2
   - Vista - Custom Installation on page 1-3
   - Windows XP - USB, Custom on page 1-3
   - Windows XP - Parallel Port (LPT) on page 1-4
   - Windows XP - Network Connection, Custom on page 1-4
Note: KPrint installs a client port monitor that enables Windows TCP/IP printing to any network card connected to Kyocera printing systems. KPrint supports LPR and IPP printing. For the KPrint Installation instructions, refer to your CD. KPrint is now a standalone installer.

Express Installation

Express mode is for a Universal Serial Bus (USB) or network connection only. The installer can find the printer if it is turned on and connected by USB or network cable. For the simple, default installation, select Express Mode Installation. In the Custom method you are able to choose which software packages to install and specify the port. To use the Custom method, see Custom Installation on page 1-2.

Windows XP and Vista - Express Installation

In Windows Vista the installation dialog boxes have a slightly different appearance, but the steps are the same.

1 For the simple, default connection select Express Mode and then click Next.

After you select Express Mode and click Next, Discover Printing System opens and looks for your printer. If Discovery does not find your printing system, ensure that it is properly connected by USB or network cable and that it is turned on, and then retry Discovery.

2 At the Discover Printing System page, select the printing system you would like to install and click Next.

Note: If the Found New Hardware Wizard appears, click Cancel. If the Hardware Installation warning dialog box appears, click Continue Anyway.

3 In Printer Settings you can assign a name to the printing system. This is the name that appears in Windows Printers and Faxes and in the printer lists in applications. You can also choose to share this printer with others or set this printer as the default printer. Make your selection from the following choices, and then click Next.

• Share your printers with others
• Set the printer system as the default

4 In the Confirm Settings page, click Install if the settings are correct. Click Cancel to correct the settings.

5 The Printer Installed Successfully screen appears. Click Finish to exit the Printer Installation Wizard and return to the CD-ROM main menu.

The installation of the printer is now complete. If prompted, restart your system.

Custom Installation

When using the Custom method you can specify the printer port and choose which software packages to install. For example, if you do not want to overwrite your existing fonts, choose the Custom mode and then clear Fonts in the Custom Installation page (shown in step 2 on page 1-4).
**Vista - Custom Installation**

1. In the **Installation Method** page, select a custom installation then click **Next**.

2. In the **Custom Installation** page, ensure that the KX Driver is selected as the product and then click **Next**.

3. The **Discover Printing System** page appears.

   To find a printing system already turned on and connected to the network, click **Discover**. and go to **step 4** on page 1-3.

   -OR-

   To manually select your printing system and port select **Custom select** and then click **Next**.

4. The **Printer Port** page appears. If the port you want to use appears in the **Port name** list, select it and click **Next**, then go to **step 4** on page 1-3.

   To create a new port, click **Add Port** and then click **Next**. The Add Port Wizard page appears.

**Add Port Wizard in Vista**

1. At the **Welcome** page, ensure that the printing device is on and connected to the network, then click **Next**.

2. Type the printer name or IP address and then click **Next**.

3. After the port has been created, the **Completing the Add Standard TCP/P Printer Port Wizard** page shown below appears. Click **Finish** to close the Add Port Wizard page and return to the installation wizard.

**Vista Custom Installation, continued from page 1-3**

4. The **Printing System** page appears. From the list, select the **Printing System** to install, and click **Next**.

5. In **Printer Settings** you can create a custom name to the printing system. This name appears in Windows **Printers and Faxes** and in the printer lists in applications. You can also choose to share this printer with others or set this printer as the default printer. Make your selections and then click **Next**.

6. In the **Confirm Settings** page, click **Install** if the settings are correct. Click **Cancel** to correct the settings.

7. The **Printer Installed Successfully** page appears. Click **Finish** to exit the Printer Installation Wizard and return to the CD-ROM main menu.

   The installation of the printer is now complete. If prompted, restart your system.

**Windows XP - USB, Custom**

1. Ensure that your printer and computer are connected using the Universal Serial Bus (USB) cable.
Windows XP - Parallel Port (LPT)

1. In the Installation Method page, select **Custom Mode > Driver**. If you want to install the fonts, also select **Utilities**.
2. In the Connection Type page, select **Universal Serial Bus (USB)**, and then click Next.
3. The Printing System appears in certain conditions, for example, when the installer cannot detect the USB connection. From the list, select the printing system to install, and click Next.
4. In the Custom Installation page, ensure that the KX Driver is selected as the product and then click Next.
5. In the Confirm Settings page, click Install if the settings are correct. Click Cancel to correct the settings.

**Note:** If the Found New Hardware Wizard appears, click Cancel. If the Hardware Installation warning dialog box appears, click Continue Anyway.

The installation of the printer is now complete. If prompted, restart your system.

Windows XP - Parallel Port (LPT)

1. In the Installation Method page, select **Custom Mode > Driver**. If you want to install the fonts, also select **Utilities**.
2. In the Connection Type page, select **Parallel Port (LPT)**, then click Next.
3. The Printing System appears. From the list, select the printing system to install, and click Next.
4. In the Custom Installation page, ensure that the KX Driver is selected as the product and then click Next.
5. In Printer Settings you can assign a name to the printing system. This is the name that appears in Windows Printers and Faxes and in the printer lists in applications. Here you can also choose to share this printer with others or set this printer as the default printer. Make your selections and then click Next.
6. In the Printer Port page, select a port, and then click Next.
7. In the Confirm Settings page, click Install if the settings are correct. Click Cancel to correct the settings.
8. In the Printer Installed Successfully dialog box. Click Finish.

The installation of the printer is now complete. If prompted, restart your system.

Windows XP - Network Connection, Custom

1. In the Installation Method page, select **Custom Mode** for Driver or Utilities. Later, you can choose to install a KX Driver or mini-driver and fonts, a scanner driver, and KMnet for clients.
2 In the **Connection Type** page, select **Network connection** and then click **Next**.

3 In the **Network Port Type** page select a port type. If you select **Standard TCP/IP** port, the installer automatically creates a new port if needed.

4 In the **Printing System** page, select the model to install, and click **Next**.

5 In **Custom Installation** select the software packages you want to install, and clear those not intended for installation. Click **Next**.

6 In **Printer Settings**, you can assign a name for the printing system. This name appears in Windows **Printers and Faxes** and in the printer lists in applications. You can also choose to share this printer with others or set this printer as the default printer. Make your selections and then click **Next**.

7 In the **Standard TCP/IP Port** dialog box, you can select **Discover Printing System** or **Host name or IP address**.

   The **Discover Printing System** searches the network for the printer. After it is found select the printer and then click **Next**. To use **Host name or IP address**, type the IP address or host name and then click **Next**.

8 In the **Confirm Settings** page, click **Install** if the settings are correct. Click **Cancel** to correct the settings.

9 After the installation is complete, the **Printer Installed Successfully** page appears. The installation of the printer is now complete. If prompted, restart your system.

### Installing Optional Components

You can expand the functions of your printer driver by installing optional components that compliment the ways in which you use your printer. Available components may include Common Profiles and Plug-ins.

A **plug-in** is a small computer program that interacts with a larger program to provide additional functionality. An example is Security Watermark, which is available for Kyocera printer drivers. Installing the plug-in adds Security Watermark functionality to the printer driver, adds a Security Watermark icon to the Advanced tab, and adds the dialog boxes that are used to set up a Security Watermark.

1 In the CD Main Menu select **Advanced Tools**.

2 On the **Advanced Tools** page, select **Optional Printer Components**.

3 The **Optional Components Wizard** dialog box appears. Click **Next** to install optional components or **Cancel** to close the wizard.

4 The **Select Printer** page appears. From the list, select the optional components you want to install and click **Next**.

5 The **Select Components** page appears. Select the components to install, and click **Next**.

Other pages, such as **Select Common Profiles** and **Select Plug-In Modules** may appear, depending on what selections are made here.
6 In any **Select** pages that appear make your selections and click **Next**.

7 In the **Confirm Settings** page, click **Install** if the settings are correct. Click **Cancel** to correct the settings.

8 The **Printer Components Installation Completed** page appears. Click **Finish**.

When you have completed installing printers and optional components, if prompted, restart your system.

**Product Library CD**

Selections in the Product Library include **Install Software**, **Remove Software**, **Advanced Tools**, **Documentation**, **Software Release Notes** and **Select Language**. Remove software provides a tool to eliminate the KX driver from your computer. The software release notes provide information about the contents of the CD-ROM, and known driver and hardware issues.

Click **Documentation** to view a list of available manuals.

You can select your interface language from the language menu. The Product Library menus use the selected language.

**Installing using the Add Printer Wizard**

This section describes how to install a printer driver using the **Add Printer Wizard**.

1 Click **Start** in the Windows taskbar, and click **Printers and Faxes** to open the **Printers and Faxes** window.

2 Click **Add a printer** in the **Printer Tasks** group box on the left.

**Note:** The **Add Printer Wizard** can also be launched by clicking **Add printer** in the **File** menu of the **Printers and Faxes** window.

3 The **Add Printer Wizard** page appears. In the **Welcome** page, click **Next** and follow the instructions.

4 When the **Completing the Add Printer Wizard** page appears, click **Finish**.
Installation of the printer driver is now complete. If prompted, restart your system.
2 Printer Properties

This chapter explains how to customize the following printer driver settings:

- Accessing Printer Properties
- Installing Optional Devices
- User Settings
- Page Description Language (PDL)
- Administrator Settings
- Compatibility Settings

Follow the steps below to set your preferred options as the default settings. These default settings can be changed temporarily when printing from Windows-based applications.

Accessing Printer Properties

1. Click **Start** in the Quick Launch toolbar and click **Printers and Faxes**. The **Printers and Faxes** window appears.
2. Right-click the printer icon in the **Printers and Faxes** window.
3. Click **Properties** in the list. The **Properties** dialog box appears.

Installing Optional Devices

In the **Printer Properties** dialog box, go to the **Device Settings** tab. For each optional device installed in your printing system, select the equivalent setting under the **Device Options** list. Available devices include finishers, paper feeders, large capacity feeder, hard disk, mailbox, and folding unit.

For models connected to a network, the **Auto Configure** button can be used to detect all available devices. See **Auto Configure** for more information. You can also specify the memory setting, PDL (Page Description Language), settings for the user, and more.

Auto Configure

Auto Configure detects the installed device options on the printing system if it is connected over a network. This button appears in the **Device Settings** tab.

Auto Configure can detect printing system devices such as input devices, output devices, and hard disk size. Then it updates the **Device options** list in the **Device Settings** tab. Auto Configure keeps the printer driver’s **Device Settings** consistent with the actual printing system devices.

**Note:** Not all installed devices are detected by using Auto Configure. Before selecting **OK** in the **Device Settings** tab, check the settings to make sure they are correct.
To use this feature, click **Auto Configure**. An "in progress" message appears, saying "Communicating with the printer to obtain setting information. Please wait a moment."

The check box settings in the **Device options** list change and the Preview image is updated according to the device options installed. Memory information also changes based on the setting information returned.

Under the following conditions the Auto Configure tool cannot communicate with the printing system:

- The printing system is powered off or is in the middle of the startup process. In such cases, Auto Configure displays the following message after the time out: "Please verify that the printer is powered on and ready to print."
- The Windows XP firewall prevents the communication. It opens a Windows Security Alert dialog box with this message: "Do you want to keep blocking this program? (Keep Blocking, Unblock, Ask me Later)."

The Microsoft Windows XP Firewall settings can be changed to allow communication between the printing system and your computer. The default setting for Windows XP Service Pack 2 is for the Windows Firewall to be set to **On**.

When the Windows Security Alert dialog box appears, click **Unblock** to allow communication between the printing system and your computer.

When you click **Unblock**, Auto Configure is added to the **Windows Firewall > Exceptions > Programs and Services** list. The Windows Firewall is accessed through the Control Panel.

Auto Configure currently supports only TCP/IP ports for Microsoft Windows 2000, XP and Vista operating systems.

A TCP/IP port can be either an IP address or the printing system name (Host name).

**Device Options**

1. Click the **Device Settings** tab.
2 Under **Device options** in the **Device Settings** tab, select the check boxes for devices installed in your printing system.

![Device options](image)

**Note:** Some devices cannot be installed simultaneously. For example, an internal finisher and a 1000-sheet finisher cannot be used at the same time. After you have selected a device, other devices are marked with a red X, preventing the selection of conflicting devices.

When you select the check box of an optional device shown in blue, a sub-dialog box appears with additional setting details. If a device option check box is already selected, double-click the device option to open the sub-dialog box.

The **Hard Disk Settings** dialog box appears if you select the **Hard disk** option, enabling the configuration of Custom boxes. For further details, see **Custom Box** on page 8-2.

3 In the **Memory** box, select the memory capacity of your printing system. This setting is required to optimize the downloading of printing system fonts.

**Punch Unit Settings**

When you select the check box for a finishing device shown in blue in the **Device options** list, such as Finisher or Multi Finisher, the **Punch Unit Settings** dialog box appears. If the device listing is already selected, double-click the option to open the **Punch Unit Settings** dialog box.

Select **2 Hole**, **2 & 3 Hole** (for inches), or **2 & 4 Hole** (for millimeters) punch option depending on the optional Punch Unit attached to your finisher.
Assigning Custom Boxes

If you select the Hard disk check box, the Hard Disk Settings dialog box appears and virtual mail boxes can be created. For further details, see Custom Box on page 8-2. If the device listing is already selected, double-click the option to open the Hard Disk Settings dialog box.

Note: An installed hard disk supports the following options: Custom box, Quick Copy, Proof and Hold, Private Print, and Job Storage.

User Settings

The following user information can be configured by selecting User in the Device Settings tab.

- Identification
- Unit of Measurement
- Language Preference Selection

Identification

In this dialog box, type user name and department information to be used with the Job Storage feature. For further details, see Job Storage (e-MPS) on page 8-1.

1 In the Device Settings tab, click User.

2 The User Settings dialog box appears. In the User name and Department text boxes, type up to 31 characters.
   - Type the preferred name in User name text box.
   - Type the user's department or group name in the Department text box.

3 Click OK.

Unit of Measurement

The unit of measurement is used for the following settings:

- Custom Page Sizes setting in the Page Sizes section in the Basic tab
- Spacing setting in the Watermark Add and Edit dialog boxes
- Poster settings in the Layout tab.

In the User Settings dialog box, select either inches or millimeters.
Language Preference Selection

The Language preference option specifies the user interface language of the Device Settings tab of Printer Properties and all tabs of Printing Preferences. Available languages vary depending on your locale and your computer settings.

Select the preferred language from the Language preferences list. To activate the new language, click OK in User Settings and then in the Properties dialog box.

Page Description Language (PDL)

You have the option to change the Page Description Language (PDL) by selecting PDL in the Device Settings tab. You can choose from PCL XL, PCL 5e, KPDL (Kyocera Page Description Language), or PDF. The default is PCL XL, which is suitable for most printing purposes. After you select a PDL, the selection appears in the lower corner of the Preview image.

PDL Settings

1. In the Device Settings tab, click PDL.

2. The PDL Settings dialog box appears. Select the desired language from the Select PDL list. See the table below for options and descriptions.
In **GDI compatible mode**, vector graphics are rasterized for printing as bitmap images. Use the **GDI compatible mode** option to improve the graphic output quality created by the application. Due to memory restrictions, this feature is not available in certain printing environments.

### Option | Description
--- | ---
**PCL XL** (color and monochrome printing systems) | The most recent version of HP PCL and PCL 6. This PDL includes PCL 5e features. Enhanced over PCL 5e in these areas: • Reduced file size • Better print speed • Faster return to application • Lacks backward compatibility with earlier PCL versions

**PCL 5e** (monochrome printing systems) | Specifies PCL 5e as the PDL. • Fully compatible with earlier PCL versions • Bidirectional communication support • Wide selection of fonts for use with Microsoft Windows applications • Allows more options for utilizing PRESCRIBE commands within applications • Quality when printing complex graphics may be lower

**KPDL** (color and monochrome printing systems) | Specifies KPDL as the PDL. KPDL is used when printing from applications that support PostScript 2 or 3. • An optional KPDL upgrade kit may be required for some models. • Kyocera’s emulation of PostScript printing • Strong graphics reproduction • Print speeds may be slower than PCL 5e. • Requires more printing system memory than PCL 5e. • Enables native TrueType font downloading • Supports most **Graphics settings** options

**PDF** (Portable Document Format) | Lets you print or save documents from multiple sources to Adobe PDF format. The PDF format is independent of the operating system and application software used to create documents. Output to PDF is a plug-in that lets you print or save documents from multiple sources to Adobe PDF format. For information about installing the Output to PDF plug-in, see **Installing Optional Components** on page 1-5. • Use as an alternative to existing commercial applications for creating PDF documents. • Documents saved as PDF retain their original appearance, and can be viewed and printed with the free Adobe Reader on Windows, Mac OS, and UNIX platforms. **Note:** With PDF selected as the Page description language, only a limited set of driver options are available.
3 **Settings** is available when the PDL is set to PCL XL, KPDL, or PDF.

### PCL XL

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Disable auto media type       | A check box control for disabling automatic switching of the paper source. If the selected cassette runs out of paper:  
| switching                     | **Cleared:** The printing system automatically switches to another cassette loaded with the same page size and media type.  
|                               | **Selected:** Printing stops until you load more paper into the cassette.                                                                 |

### KPDL

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow data passthrough</td>
<td>Data passthrough reduces errors when printing complex jobs from applications that use PostScript formatting.</td>
</tr>
</tbody>
</table>

### PDF

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Embed fonts</td>
<td>Select to ensure document fonts appear accurately in the PDF file on screen. This option significantly increases the file size and ensures accurate reproduction.</td>
</tr>
<tr>
<td>Compress data</td>
<td>Select to enable Flat compression for the generated PDF document. It significantly reduces the file size. Additional compression options are available within Adobe Acrobat.</td>
</tr>
</tbody>
</table>
| Security                 | Select 40-bit or 128-bit encryption for the print job and set passwords for opening a document and/or access to changing the document restrictions within Adobe Acrobat.  
|                           | Save to file must be checked for security to create secure PDF documents. Click Settings for additional security settings.                  |
| Save to file             | Select to save the document as a PDF file. Password settings are available in the Security Settings dialog box.                                |

**Note:** If Save to file is selected, the document is not printed when you click **OK** in the Print dialog box.
Security Settings

Let you select an encryption level and create passwords for the generated PDF file. To access the Security Settings dialog, follow these steps:

1. Open Printer Properties/Device Settings
2. Click on the PDL. button
3. For Select PDL:, choose PDF then click on the Settings.
4. Place a checkmark next to Security then click on Settings.

The following security options are available:

- **Encryption**: Encryption provides password protection so that a document cannot be easily opened or altered by unauthorized users.
- **128-bit**: Provides high level security for Adobe Acrobat and Adobe Reader 5.0 or later.

**Note**: Adobe Acrobat 3 and 4 cannot open 128 bit encrypted PDF documents.

- **Passwords**: Select passwords for changing security settings and for opening a document. Passwords are supported up to 16 characters in length.
- **Requires a password to change security settings**: Type an Owner password. Within Adobe Acrobat, this password is be required to change the document restrictions in the Files/Properties/Security section.
- **Requires a password to open document**: Type a User password. The user password must be entered at the time the PDF document is opened. This password must be different from the owner password used to control document restrictions.

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Security Settings</td>
<td>Lets you select an encryption level and create passwords for the generated PDF file. To access the Security Settings dialog, follow these steps:</td>
</tr>
<tr>
<td></td>
<td>1. Open Printer Properties/Device Settings</td>
</tr>
<tr>
<td></td>
<td>2. Click on the PDL. button</td>
</tr>
<tr>
<td></td>
<td>3. For Select PDL:, choose PDF then click on the Settings.</td>
</tr>
<tr>
<td></td>
<td>4. Place a checkmark next to Security then click on Settings.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Encryption</th>
<th>Encryption provides password protection so that a document cannot be easily opened or altered by unauthorized users.</th>
</tr>
</thead>
<tbody>
<tr>
<td>128-bit</td>
<td>Provides high level security for Adobe Acrobat and Adobe Reader 5.0 or later.</td>
</tr>
</tbody>
</table>

**Note**: Adobe Acrobat 3 and 4 cannot open 128 bit encrypted PDF documents.

- **Passwords**: Select passwords for changing security settings and for opening a document. Passwords are supported up to 16 characters in length.
- **Requires a password to change security settings**: Type an Owner password. Within Adobe Acrobat, this password is be required to change the document restrictions in the Files/Properties/Security section.
- **Requires a password to open document**: Type a User password. The user password must be entered at the time the PDF document is opened. This password must be different from the owner password used to control document restrictions.
Administrator Settings

The following settings can be specified by selecting Administrator in the Device Settings tab.

- User Login
- Job Accounting
- Administrator Password

Note: The Administrator Settings dialog box appearance and options may vary depending on your printing system.

User Login

Use User Login to add users with a user name and password. Use this feature to limit printing privileges to specified users, for secure printing and job accounting. The number of pages/job printed by each user can be tracked by the printer. See your printing system’s Operation Manual for information about tracking usage at the printer.

User login provides job restriction by user, in contrast to the Job accounting feature, which assigns privileges by division or department. A maximum of 1000 login user names and passwords can be registered at the printing system. One hundred user names and passwords can be stored in the printer driver.

Note: Job accounting and User login cannot be used at the same time.

Users added in the printer driver should also be manually registered at the printing system's operation panel.

The settings selected here are applied to every print job sent from this computer. The available options are as follows:

- Use specific login user name
  Select this option and type a user name and password to use the same user login for every print job. If this option is selected, the user does not have to type the name and password for each print job.
- Prompt for login user name
When a user prints a document, the driver prompts you for a user name and password. You can use a Login User Name that is not on the list, and it is not added to the list. When sending a print job, type a Login User Name and password when prompted, then click OK to print.

- **Prompt for login user name and validate**
  Whenever a user sends a job to print, the driver prompts for user name and password. For the job to print, the user name and password entered must be on the Login User Name List (see Add Login User Names on page 2-10). You can use the Login User Names entered in the Login User Name List of the driver. When sending a print job, type a Login User Name and password when prompted, then click OK to print. This option ensures that the job prints only when the selected Login User Name is saved in the driver.

- **Verify the printing system’s login user for each user (PC)**
  When this option is selected, the driver asks for a Login User Name and password the first time the a job is sent to the printer. The Login User Name must be one that is not yet registered on the Login User Name List. The name entered is added to the list, and thereafter the printer driver does not prompt for a user name and password.

**Add Login User Names**

1. In the Administrator Settings dialog box, select User login.
2. Click Login User Name List.
3. Click Add.

   The name and password are case-sensitive. The name and password can each be up to 64 alphanumeric characters. The user name is automatically filled in with the Login User Name by default, but can be changed. The user name can be up to 20 characters.

**Import and Export the Login User Name List**

This section explains how to import and export your Login User Name lists. You can save the list of Login User Names created in the previous section to your personal computer or network. After saved, the list can be imported into other printer drivers.

**Import**

1. In Administrator Settings, click Login User Name List, then click Import.
2 Use **Look in** at the top of the window to find for the file to import, or type the file name, and click **Open**.

![Image of Import Login User Names List]

3 You can then select the imported file from the list of **Login User Names**.

**Export**

1 In the Administrator Settings dialog box, click **Login User Name List**, then click **Export**.

2 In **Login User Names** select a file to export, and click **Export**.

3 Use **Save in** to browse to a location to save the file, type the file name, and click **Save**.

**Job Accounting**

With **Job accounting**, you can assign account IDs to print jobs, or work with IDs already created at the printing system. Job accounting features help you manage and control the number of copies in a printing system. After IDs are created, from the printing system operation panel you can view the number of copies attached to a specific ID or limit the number of copies for individual IDs. IDs for newer models must be 8 digits or less.

**Copy management** must be set to ON at the printing system to use this feature. Depending on the printing system model, a maximum of 500 account IDs can be assigned at the printing system and stored in the printer driver. For complete information about the job accounting features of the printing system, please see the *Operation Guide* for your particular model.

**Note:** **User login** and **job accounting** cannot be used at the same time in the driver.

Job accounting includes the following options:

**Use specific account ID:** This option can be used to specify a single account ID to manage the print jobs of a specific user. When the user prints, your jobs are sent with the account ID. You can use **Password protect administrator settings** to protect access to the **Administrator Settings** dialog box, so that the user cannot see or change this setting.
Note: Some versions say Password protect instead of Password protect administrator settings. Both open the same dialog box.

Prompt for account ID: This option can be used to prompt the user for an account ID when printing. When sending a print job, type an account ID when prompted, then click OK to print. The account ID must be one that has been registered at the printing system, or the job does not print.

Prompt for account ID and validate: This option can be used to prompt the user to specify an account ID that is saved in the driver. When sending a print job, type an account ID when prompted, then click OK to print. The account ID is validated against the account ID list, so you must type an ID from the list, or you cannot print.

Display account ID list: This option can be used to display the list of IDs entered in the account ID list of the driver when sending a print job. This gives the user a selection of account IDs to choose from.

Account ID List: This option can be used to add, edit, or delete account IDs from the account ID list of the driver. You can also give the IDs text descriptions to help manage and track them. After an account ID list is created, the list can be exported as a group by saving it as a text file (.CSV). To import an account ID list, browse for an existing list and save it in your printer driver.

Administrator Password

You can set a password for the Administrator Settings dialog box. After a password is typed in, the administrator settings dialog box cannot be opened until the password is typed in the Enter Password dialog box. This prevents unauthorized personnel from changing the administrator settings.

Set the Password

1 In the Administrator Settings dialog box, select the Password protect check box to open the Password dialog box.

2 In the Password dialog box, enter the new password using between 4 and 16 characters in the Password text box. Re-enter the password in Confirm password and click OK.

Change the Password

1 In the Device Settings tab, click Administrator.

2 The Enter Password dialog box appears. Type the password and click OK.

3 The Administrator Settings dialog box appears. Clear the Password protect check box. A Password message appears.

4 Click OK.

Compatibility Settings

This feature supports compatibility for media source values unique to the printer driver, such as those for cassettes or feeders, so your newly installed KX Driver maintains identical media source support with the driver it replaces, whether for this
driver or one from another manufacturer. If media source macros exist for the older
driver, then the alignment of media source values maintain support without the need
to change the macros.

Use the Driver Info utility, available on the Product Library CD, to compare the source
values for all installed drivers.

If the values for a given media source differ between the old and new printer drivers,
reassign the value in the new driver to match the value in the previous driver.
Compatibility settings can be adjusted by selecting **Compatibility** in the **Device
Settings** tab.

1. In the **Device Settings** tab, click **Compatibility**.

2. The **Compatibility Settings** dialog box appears. From the **Media source
enumeration** list, select the paper supply method. The current value is listed in the
**Enumerated value** box.

3. Type a new Enumerated value for the media source and click **OK**. You can also
restore all the parameters to the default by clicking **Reset**.

The other options in the **Compatibility Settings** dialog box include:

- **Disable face-up reverse page order**
  This option prevents reverse order printing if face-up output is selected.
- **Ignore application collation**
  Use this option to bypass the **Collate** setting in the application, and give priority
to the printer driver setting.
- **Combine source and media type lists**
  This option changes the Basic tab of **Printer Properties** so that **Media type** and
**Source** are combined into one box, labelled **Source**.
3 Printing Basics

This chapter describes the following printing tasks when printing from Microsoft Windows applications.

- Basic Printing Tasks
- Printing on Paper of Non-Standard Sizes
- Duplex Printing
- Reverse Order Printing
- Collating Modes

Basic Printing Tasks

The steps required to print a document created with an application are explained below. You can select the printing paper size and output destination.

Basic Printing

1. Insert the proper paper size (such as A4) into the printing system's paper cassette or MP tray.

2. From the application’s File menu, select Print. The Print dialog box appears. Select the desired printing system from the list of available printing systems.

3. Specify the number of copies to print in the Number of copies box. You can print up to 999 copies. When printing two or more copies, enable the Collate check box for collation. Number of copies and Collate can also be specified in the Basic tab. See page 3-10 for further information.

If Ignore application collation is selected in the Compatibility Settings dialog box, the Print Collate setting is not applied.

When using Microsoft Word, we recommend that you click Options, and for default tray select Use printer settings.

![Print Dialog Box](image)
4 Click **Properties** to open the **Properties** dialog box.

5 In the **Basic** tab, click **Page Sizes** to open the **Page Sizes** dialog box. In the **Select page size** list, select a page size for the print job.

![Page Sizes dialog box](image)

6 Click **OK** to return to the **Basic** tab. Click **OK** to return to the **Properties** dialog box.

   For best results when printing on transparencies or recycled paper (the back side of paper which has already been printed on), from the **Media type** list select the media type. For further details, see **Media Types** on page 3-3.

   The printing system automatically selects the paper size that matches the size specified above. A message appears requesting you to load paper into the MP tray if the proper paper size is not available.

7 Click the **Source** list to specify the paper cassette for printing.

8 Choose either **Portrait** or **Landscape** to match the document page orientation. You can rotate the document 180 degrees by selecting the **Rotated** check box.

9 Click **OK** to return to the **Print** dialog box.

10 Click **OK** to start printing.

**Print Sizes**

   This section describes how to print documents of different sizes than the original document. The document image is adjusted to match the size you select. If you would like to manually input the Scaling percentage, see **Scaling** on page 4-6.

1 In the **Properties** dialog box, from the **Basic** tab click **Page Sizes**.

2 In the **Page Sizes** list, select the document’s paper size and click **OK**.
3. In the **Basic** tab, click the **Print Size** list and select the preferred output paper size.

![Print Size settings in the Basic tab](image)

4. Confirm the proper paper size is loaded. Click **OK** to return to the **Print** dialog box.

5. Click **OK** to start printing.

   The source document is automatically scaled to fit the output paper size.

### Media Types

The printing system automatically selects the paper size specified in the **Page Sizes** setting in the **Basic** tab by default when you are printing on regular paper. However, the printing system supports a wide variety of printing media depending on your printing system model.

You can specify the media type in the **Media type** setting for auto media selection when using non-standard types of printing media, such as recycled paper, labels, or transparencies. You can also specify the finishing settings for best results. Automatic selection of media types can be disabled in the PCL XL settings dialog box. For further details, refer to **Page Description Language (PDL)** on page 2-5.

Labels, transparencies, and envelopes must be printed using the MP tray. Ensure the paper is properly loaded by following the instructions outlined in the printing system's **Operation Guide**.

**Note:** The default setting is for **Source** and **Media type** to be separate items in the dialog box, but it is possible to combine them using a setting in **Compatibility Settings**. If they are combined, the **Media type** list is not available. To change this setting, open **Printer Properties** from the Microsoft Windows **Printer and Faxes** window, go to **Device settings** and then **Compatibility Settings**, and then clear the **Combine source and media type lists** selection.

When paper is properly loaded in the paper cassette, the printing system can automatically detect the paper size. However, it is necessary to use the operation panel on the printing system to assign the media type of the paper cassette so that the printing system can recognize it. The steps to specify the media settings are listed below.
Printing Basics

1. Load the paper in a paper cassette or the MP tray.

   **Note:** Use the MP tray in cassette mode (the default). For further details on MP tray modes, refer to the printing system's *Operation Guide*.

2. Specify the media type at the operation panel on the printing system.

3. Open the Properties dialog box.

4. Select the document paper size from the Print Size list.

5. From the Media type list, select the type of media for printing, then click OK.

### Options Available in the Media Type List

<table>
<thead>
<tr>
<th>Media Type</th>
<th>Usable Paper Cassettes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain 64 to 90 g/m²</td>
<td>All</td>
</tr>
<tr>
<td>Preprinted</td>
<td>All</td>
</tr>
<tr>
<td>Bond (securities)</td>
<td>All</td>
</tr>
<tr>
<td>Coated</td>
<td>All</td>
</tr>
<tr>
<td>Recycled</td>
<td>All</td>
</tr>
<tr>
<td>Vellum Less than 64 g/m²</td>
<td>All</td>
</tr>
<tr>
<td>Letterhead</td>
<td>All</td>
</tr>
<tr>
<td>Color 64 to 90 g/m²</td>
<td>All</td>
</tr>
<tr>
<td>Prepunched</td>
<td>All</td>
</tr>
<tr>
<td>High quality</td>
<td>All</td>
</tr>
<tr>
<td>Cardstock</td>
<td>MP Tray</td>
</tr>
<tr>
<td>Envelopes</td>
<td>MP Tray</td>
</tr>
<tr>
<td>Thick</td>
<td>MP Tray or paper cassette</td>
</tr>
<tr>
<td>Rough 90 to 200 g/m²</td>
<td>MP Tray or paper cassette</td>
</tr>
<tr>
<td>Labels</td>
<td>MP Tray</td>
</tr>
<tr>
<td>Transparency</td>
<td>MP Tray</td>
</tr>
<tr>
<td>Custom (1-8)</td>
<td>Refer to <em>Operation Guide</em></td>
</tr>
</tbody>
</table>

After printing begins, the printing system automatically selects the paper to match the paper size and specified media type.

If the paper loaded does not match the size, type, or both, a message appears asking you to load paper in the MP tray.

### Printing on Paper of Non-Standard Sizes

To use custom sizes of paper in your printing system, you must first define the custom paper sizes in the Properties dialog box.
Note: For custom paper, supply the paper using the universal (adjustable) paper cassette or the MP tray.

Custom Paper Sizes

1. Load the custom paper into the printing system. For further details, refer to the printing system’s Operation Guide.

2. Click Start in the Windows taskbar and then select Printers and Faxes. The Printers and Faxes window appears.

3. Right-click the printer icon and select Properties to open the Properties dialog box.

4. Click Printing Preferences to open the Printing Preferences dialog box.

5. Click Page Sizes. The Page Sizes dialog box appears.

6. Click New to display Custom_01 in the Name box. You can replace Custom_01 with the name for your new custom paper size. The name can be up to 31 characters.

7. Type the measurements in the Height and Width boxes in millimeters or inches. The unit (inches or millimeters) is selected in the User Settings dialog box, accessed from the Device Settings tab. For further details on changing the unit, refer to User Settings on page 2-4.

Size limits for custom paper are listed in the table below.

<table>
<thead>
<tr>
<th>Size</th>
<th>Cassette</th>
<th>MP tray</th>
<th>Duplex unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum (A4 printing systems)</td>
<td>148 × 210 mm (5.8 x 8.3 inches)</td>
<td>70 × 148 mm (Portrait)</td>
<td>148 × 216 mm</td>
</tr>
<tr>
<td>Maximum (A4 printing systems)</td>
<td>216 × 356 mm (8.5 x 14 inches)</td>
<td>216 × 356 mm (Portrait)</td>
<td>216 × 356 mm</td>
</tr>
<tr>
<td>Minimum (A3 printing systems)</td>
<td>148 × 210 mm (5.8 x 8.3 inches)</td>
<td>70 × 148 mm</td>
<td>148 × 210 mm</td>
</tr>
<tr>
<td>Maximum (A3 printing systems)</td>
<td>297 × 450 mm (11.7 x 17.7 inches)</td>
<td>310 × 458 mm</td>
<td>297 × 431.8 mm</td>
</tr>
</tbody>
</table>

Sample Paper Measurements (150 mm x 200 mm)

8. Click OK.
Printing with Custom Paper Sizes

1. Select **Print** from the **File** menu. From the application’s **Print** dialog box, open **Print Properties**.

2. In the **Basic** tab, select the name of your saved paper size in the **Print Size** list.

3. From the **Source** list, select the source cassette for the custom page size.

4. Click **OK** to return to the **Print** dialog box.

5. Click **OK** to start printing.

Duplex Printing

This section describes how to enable the duplex printing option. In order to activate this printing option, a duplex unit must be installed, and additional memory may be required. For further details, refer to your printing system’s *Operation Guide*. For information on Booklet printing, see *Booklet Printing* on page 4-2.

The paper sizes and media types listed in the table below cannot be used for duplex printing:

<table>
<thead>
<tr>
<th>Paper sizes</th>
<th>Media Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>A3 wide</td>
<td>Transparencies</td>
</tr>
<tr>
<td>A6</td>
<td>Labels</td>
</tr>
<tr>
<td>B6</td>
<td>Thin paper</td>
</tr>
<tr>
<td>Postcards</td>
<td>Envelopes</td>
</tr>
<tr>
<td>Double postcards</td>
<td>Postcards</td>
</tr>
<tr>
<td>Envelopes</td>
<td></td>
</tr>
<tr>
<td>Western size 2 (114 × 162 mm)</td>
<td></td>
</tr>
<tr>
<td>Western size 4 (105 × 235 mm)</td>
<td></td>
</tr>
</tbody>
</table>

Print on Both Sides

1. Within your application, select **Print** from the **File** menu. Then, from the **Print** dialog box, open **Properties**.
From the Basic tab, select **Print on Both Sides**. Select **Flip on Long Edge** or **Flip on Short Edge**.

**Flip on Long Edge**
- Portrait
- Landscape

**Flip on Short Edge**
- Portrait
- Landscape

Click **OK** to return to the Print dialog box.

Click **OK** to start printing.

**Reverse Order Printing**

You can print document pages in reverse order, from the last page to the first. The reverse order printing function places the order of pages into reverse numerical order as shown below.

**Print Pages in Reverse Order**

1. Open the **Properties** dialog box.
2. From the Basic tab, select the output tray from the **Destination** list.
3. Select **Reverse page order**. If **Reverse page order** does not appear, select another choice other than Printer default for the **Destination** output tray.
4. Click **OK** to return to the Print dialog box.
5. Click **OK** to start printing.
Collating Modes

By attaching a sorter to your printing system, you can specify how printed documents are stacked in the output trays after printing.

The number of output trays and their receiving capacity (the number of sheets) varies depending on the sorter model. Refer to your sorter's Operation Guide.

Frequently, the application settings are given priority, causing a change in the sorter output method depending on the application. Verify these settings before printing your documents.
Sorter Modes

There are three sorter modes available. These modes are selected in the Basic tab:

Collating

- Collating in sorter mode produces the specified number of copies as complete sets of documents in each tray.
- The document is printed following the page order and received in each tray. The number of document copies must not exceed the number of trays. If a tray becomes full, the printing system pauses and shows a message to remove the paper from the tray. After the paper is removed, printing resumes for the remaining number of copies.

Non-collating

- Non-collating mode produces the specified number of copies but divides the document for output in each tray, with page 1 in tray 1, page 2 in tray 2, and so on. For example, printing 20 copies of a four page document using grouping produces 20 copies of page 1 in tray 1, 20 copies of page 2 in tray 2, and so on.
- The number of document copies must not exceed the sheet capacity of any tray. When a tray reaches capacity, the printing system pauses and shows a message to remove the paper from the tray. In addition, the maximum document page length must not exceed the number of sorter trays. When a tray reaches capacity, the printing system pauses and shows a message to remove the paper from the tray.

Mailbox

- The mailbox mode sends copies to specified user trays, which is useful when the printing system is shared among different users. For example, specifying tray 5 sends the printed document to tray 5.
- When a tray reaches capacity, the printing system pauses and shows a message to remove the paper from the tray.
- Mailbox is a physical mailbox.
Collate

1. Open the **Properties** dialog box.

2. From the **Destination** list, select a face-down destination, such as **Finisher (face-down)** or **Top Tray (face-down)**.

3. Select the **Collate** check box.

4. Select the number of complete sets in the **Number of copies** box. When printing using the collate option, specify the number of copies not to exceed the number of trays. The document page length must not exceed the tray capacity (for example, 200 sheets).

5. Click OK to return to the **Print** dialog box, and click OK to begin printing. The specified number of copies is produced in separate trays.

Non-Collating

Clearing the **Collate** check box produces page 1 in tray 1 and page 2 in tray 2.

1. Open the **Properties** dialog box.

2. From the **Destination** list, select **Finisher (face-down)** or **Top Tray (face-down)**.

3. Clear the **Collate** check box.

4. Click OK to return to the application’s **Print** dialog box and begin printing. The specified number of copies of each page is delivered to each tray.
4 Layout

In the Layout tab you can arrange document data on printed pages without changing the original document.

- **Booklet** prints a multi-page document in a book format that can be folded and stapled.
- **Multiple pages per sheet** prints more than one document page on a single sheet.
- Use **Poster** to print a large banner using several sheets of paper.
- **Scaling** increases or decreases the print size.

![Printing Preferences](image)

**Booklet**

Use the **Booklet** option to print a two-page layout on both sides of each sheet of paper. You can then fold and bind the booklet in the center.

You can use optional document finishers to staple the booklet. For further details on **Staple** settings, refer to **Staple** on page 5-4.

The supported paper sizes for Booklet printing are A3, B4, A4, A5, B5 (JIS), ledger, letter, legal, statement, and folio. Booklet printing can be used with Cover mode to add a cover to the booklet. For further details, refer to **Printing with Covers** on page 7-1.

**Left Edge and Right Edge Binding**

Select left edge or right edge binding of the booklet to match the direction of your written language:

- Select **Left edge binding** for languages that read left to right.
• Select **Right edge binding** for languages that read right to left.

**Booklet Printing**

1. In your application, select **Print** from the **File** menu and open **Print Properties**.

2. Click the **Layout** tab.

3. Select **Booklet**.

4. Select **Left edge binding** or **Right edge binding**.
   - To use the Stapling feature, continue to step 5.
   - To continue with Booklet printing, go to step 8.

5. Click **Basic > Destination**, and select a face-down finishing tray.

   If the **Staple** check box is not available in the **Finishing** tab, change the setting for **Destination** in the **Basic** tab to an output tray that has a stapler.

   **Booklet** is selected automatically if **Staple** is selected in the **Finishing** tab and **Booklet [fold]** is selected under **Position**. Subsequently clearing the **Booklet** option does not reset **Destination** in the **Basic** tab. To return the driver to the default settings, click **Restore Defaults**. **Restore Defaults** is available when accessing the printer driver from the application’s **Print** dialog box.

6. Select the number of copies to print.

7. Click the **Finishing** tab, and select the **Staple** check box. **Booklet (fold)** is selected automatically.

8. Click **OK** to return to the **Print** dialog box.

9. Click **OK** to start printing.
**Multiple Pages Per Sheet**

You can print multiple pages of a document on a single sheet of paper. Pages can be arranged in a variety of ways, and a border can be printed around each document page.

1. From the application’s **Print** dialog box, open **Properties**. (Select **Print** from the **File** menu, and select **Properties**.)

2. Click the **Layout** tab.

3. Select **Multiple pages per sheet**.

4. In the **Pages per sheet** list, select the number of source pages.

5. From the **Layout** list, select the horizontal and vertical direction for the page layout.

**Examples:**

- If you select six pages per sheet and select **Top to bottom and left**, the pages are arranged from the top right corner to the bottom left corner.
- If **Auto** is selected, the pages are arranged from the top left corner to the bottom right corner.

6. Select the **Print borders** check box to print a border around each document page.

**Poster**

You can print a document in a larger size than the paper supported for the printing system. The **Poster** feature allows you to increase the print size, print portions of the document on several sheets of paper, then assemble the sheets into a large banner, up to 25 times larger than the original document.
Sheets Per Page

In the Sheets per page list, select the size of the desired poster, in relation to the original document size. The list shows the number of sheets to be printed and the maximum poster size. The final size may be reduced slightly depending on selections made in the Poster Settings dialog box. For further details, refer to Poster Settings on page 4-5.

Available Poster Sizes

- Select 2 x 2 to print a poster 4 times larger than the original.
- Select 3 x 3 to print a poster 9 times larger than the original.
- Select 4 x 4 to print a poster 16 times larger than the original.
- Select 5 x 5 to print a poster 25 times larger than the original.

The dimensions shown after each option are based on the selected Page size in the Basic tab. For further details on selecting a page size, refer to Basic Printing Tasks on page 3-1.

The unit (inches or millimeters) is selected in the User Settings dialog box, accessed from the Device Settings tab. For further details on changing the unit, refer to User Settings on page 2-4.
Print Format

If you are new to poster printing, you may want to print a proof sheet, in addition to the poster, to guide you in assembling the printed poster sheets. The proof sheet shows all poster pages on one sheet with markings that show how to assemble the sheets. Under Print format:

- Select Poster pages to print only the sheets of the poster.
- Select Proof sheet to print only a one-page proof sheet.
- Select Poster pages and proof sheet to print all poster sheets and a one-page proof sheet.

Poster Settings

To make it easier to create a poster, you can print visual cues on the poster sheets that provide help in cropping and assembling the pages. In the Layout tab, click the Poster Settings button to open the Poster Settings dialog box.

You can use any combination of the following options in the Poster Settings dialog box.

- **Overlap edges**
  Select this option to duplicate the edges of document data on adjoining sheets. Poster appearance is improved when the edges overlap slightly. Select the check box, then type or select a value between 0.00 and 1.20 inches (0.0 and 30.4 mm). This option reduces the final poster size slightly.

- **Print crop marks**
  Select this option to print a border at the edges of each poster sheet. You can crop each sheet on the border before assembling the sheets. This option ensures that data on adjoining sheets matches precisely.

- **Print assembly marks**
  Select this option to print numbers at the edges of each sheet, matching numbers on adjoining sheets. Assemble each sheet edge to the same numbered edge on another sheet. For a large poster with many sheets, this option ensures that the poster assembles correctly.
Scaling

Based on the page size and print size specified in the **Basic** tab, you can increase the top and/or left margin.

![Printing Preferences dialog box](image)

**Scaling**

Click the **Layout** tab in the **Properties** dialog box, and type the scale percentage into the **Scaling (20-500%)** box, or click the up or down arrow buttons to adjust the value.
5 Finishing

This chapter describes the uses of finishing equipment. The Finishing tab is available for models that support optional finishing devices such as Internal finisher or 1000-sheet finisher.

**Note:** For some features in the Finishing tab, the caution symbol appears when the feature is unavailable. Place the pointer over the symbol for a message that tells how to activate the feature in the driver.

- **Finishing Edge** aligns the matching sides of two different page sizes in a document.
- **Staple** binds multiple document pages together with one or more staples.
- **Punch** places round hole punches in the margin.
- **Separation** physically separates document copies or multiple copies of a print job in the finishing tray.

### Finishing Edge

Finishing edge aligns the matching sides of two different page sizes in a document. For example, the long edge of an A4 page is aligned with the short edge of an A3 page; or the short edge of a letter size page is aligned with the short edge of a legal size page. Finishing edge can be used with or without the staple or punch features.
You can choose the position of staples and hole punches in a document composed of mixed page sizes. In contrast, if you are printing a mixed page size document without using Finishing edge, staple or hole punch positions depend on the paper size settings (portrait or landscape) in the paper cassettes.

Finishing edge should be selected before any other features in the Finishing tab. If set last, Finishing edge might change any settings you previously made under Staple or Punch.

In the Finishing tab, if Booklet (fold) is selected for the Staple feature, Finishing tab options are unavailable. Finishing edge makes some other features unavailable, such as Separation and Rotated. Finishing edge cannot be used with the Poster feature.

To create a gutter in the document, click Gutter. A gutter increases the blank space on the left side or top of the printed page by scaling down text and graphics. For more information see Gutter on page 5-4. For applications that do not depend on the driver for page size (such as Microsoft Word), use the application’s Page Setup dialog box to specify the sizes of the mixed pages in your document.

Page Size Combinations

Finishing edge can be used for the following combinations of page sizes:

- A4 and A3 (210 x 297 mm and 297 x 420 mm)
- B5 (JIS) and B4 (182 x 257 mm and 257 x 364 mm)
- Letter and Legal (8.5 x 11 in. and 8.5 x 14 in.)
- Letter and Ledger (8.5 x 11 in. and 11 x 17 in.)
- 16K and 8K (197 x 273 mm and 273 x 394 mm)

Using Finishing Edge

1 In the Basic tab, from the Print size list, select the size of the first page to be printed in the mixed page document.
2 In the Basic tab, from the Source list select an Auto source.

3 In the Finishing tab, select Finishing edge.

4 Select from available Position (the document edge to be finished) options, or select Custom. Positions are based on the Print size selection in the Basic tab. For more information, see Positioning Options for Finishing Edge on page 5-3.

5 Click OK in all driver dialog boxes.

6 Load each paper size (using the supported paper size pairs described in Page Size Combinations) into different paper cassettes. For example, load A4 and A3 paper so that both sizes feed the 297 mm edge; or load letter and legal paper so that both sizes feed the 8.5 inch edge.

7 Click OK in the application’s Print dialog box. If the printer driver determines the specified paper size or direction (short or long edge) is not available in the printing system, the front panel message requests you load the correct paper size into the cassette with the correct orientation.

Positioning Options for Finishing Edge

Select from available options to specify the page edges to be aligned and finished. For additional position settings, select Custom, then click Settings. Available options for Position depend on Print size, Orientation, Booklet, and Multiple pages per sheet selections. For more information see Chapter 3, Printing Basics and Chapter 4, Layout.

In the side panel display, the page image shows a blue highlighted strip to indicate the current selected finishing edge and Staple or hole punch positions, if selected. When the staple or hole punch option is used, the Position selection determines where staples and hole punches are placed. Use this image to verify your selections for Finishing edge, Staple, or Punch.

Custom Finishing Edge Settings

To select Custom for Position, click Settings to open the Custom Finishing Edge Settings dialog box. Select one of the settings. The illustrations in the dialog box help you visualize the page alignments.

In the Custom Finishing Edge Settings dialog box:
The top two settings (e.g. A4/Letter) are for the smaller size paper in the mixed page document. The second row of settings (e.g. A3/Legal/Ledger) is for the larger size paper in the mixed page document.

Select the one setting that best illustrates the edge of the mixed pages you want to align. Note that a change to one custom Finishing edge setting adjusts other selections to make them compatible with the change.

**Gutter**

Based on the page size and print size specified in the Basic tab, you can reduce or enlarge the image from 20% to 500% of the original size, or increase the top or left margin, before printing.

Click Gutter to increase the outside margins in a range from 5.0 to 25.4 mm (0.20 to 1.00 inch). The left and/or top margins can be adjusted. This is useful when you want to add extra margin space to the page for staples or hole punches. When used with duplex printing, the enlarged gutter lines up evenly on both sides of the sheet. For further details on duplex printing, refer to Duplex Printing on page 3-6.

- To increase outside margins on the left side of the page, enter a number into the Left (long edge) box. This option may not be available, depending on your Orientation and Print on both sides settings in the Basic tab.
- To increase outside margins at the top of the page, enter a number into the Top (long edge) box. This option may not be available, depending on your Orientation and Print on both sides settings in the Basic tab.
- Since the Gutter feature shifts document data to the right or down, select the Reduce image to fit check box if the printed data extends beyond the edge of the paper when changing the gutter setting. The size of the printed data is decreased slightly to fit in the printable margins of the page.
- If the document data is small enough that it does not extend beyond the edge of the paper when the gutter is increased, clear the Reduce image to fit check box.

When you want to change the page size (for example, to enlarge an A4-size brochure for printing on A3 paper), refer to Print Sizes on page 3-2.

**Staple**

The Staple feature is available on printing systems with an optional finishing device installed. If a 3000-sheet finisher and folding unit are installed, the Booklet printing feature is available. For further details, refer to Booklet on page 4-1.

After installation, optional equipment must be selected in the printer driver in the Device Settings tab. For further details, refer to Installing Optional Devices on page 2-1.
Note: Staple and Separation features cannot be used together.

If Printer default is selected as the Destination in the Basic tab, the selection of an option in the Finishing tab results in the automatic selection of a destination compatible with that finishing option. The destination is automatically updated to the first available output tray that supports the selected finishing option.

**Staple, Punch, and Separation > Offset jobs** each select the Destination automatically. If Staple > Booklet [fold] is selected, Booklet in the Layout tab is also automatically selected. If the finishing option is changed, the Destination selection is not affected.

### Using the Stapler

1. From the application’s **Print** dialog box, open **Properties**. (Select **Print** from the **File** menu, and select **Properties**.)

2. Click the **Finishing** tab, then select **Staple**.

3. Select the available stapling position: **Upper left**

   **Note:** You can increase the left or top margin to provide additional space for stapling by using the **Gutter** feature. See **Gutter** on page 5-4.

4. Select how many pages to staple together under **Count**.

   **Note:** The maximum number of sheets that can be stapled varies, depending on the selected **Page size** or **Media type**, and on the finisher model. See your finishing device’s **Operation Guide** for details.

   - **All sheets** (maximum of [---])
     - Staples all document sheets up to the displayed limit. If the document being printed has more than the maximum number of sheets, the document is not stapled. One sheet can equal two pages when duplexed.
     - For example, if the supported maximum is 50 document sheets, then a 58 sheet document is not stapled.
   - **After every [---] sheets**
     - Select this option to divide the document into sets, with a specified number of sheets in each set, then staple each set separately. You can designate from 2 sheets up to the limit displayed under **All sheets**. If the final set has fewer sheets than the limit, it is stapled.
     - For example, if stapling has been specified after every 20 sheets for a document that has 58 sheets, the print job is stapled in sets of 20, 20, and 18 sheets.

5. Click **OK** to return to the **Print** dialog box.

6. Click **OK** to start printing.

The printed document is stapled and delivered to the output tray.

For further details about stapler specifications, refer to your finishing device’s **Operation Guide**.
Punch

The Punch feature is available on printing systems with an optional finishing device installed. This feature places hole punches along the edge of the printed pages, so that the pages can be bound together or placed in a binder. Punch cannot be used when Booklet is selected in the Layout tab.

Note: Not all finishing devices support the punch feature. For further details, refer to Installing Optional Devices on page 2-1.

Using Hole Punch

1. In your application, open the Print dialog box, then open Properties. (Select Print from the File menu, and select Properties.)

2. In the Basic tab, under Destination, select a face-up or face-down finishing tray.

3. Click the Finishing tab, then select Punch.

4. Select the number of hole punches: 2 hole, 3 hole, or 4 hole. Available punch options are set in the Device Settings tab and depend on the punch unit being installed on the device and selected. For further details, refer to Installing Optional Devices on page 2-1. For information on positioning the hole punches, refer to Position the Hole Punch below.

   • For metric specification, use 2 hole and 4 hole punch options.
   • For inches specification, use 2 hole and 3 hole punch options.

5. Click OK to return to the Print dialog box.

6. Click OK to start printing.

   The print job is punched by the finishing device and delivered to the output tray.

   For further details about hole punch specifications, refer to your finishing device’s Operation Guide.

Position the Hole Punch

Note: Some models do not support the punch position option.

1. With Punch selected in the Finishing tab, click the Settings button.

2. In the Punch Position Settings dialog box, select where to place the hole punches on the page: Left, Right, or Upper.

3. In the Punch Position Settings dialog box, click OK.

4. Click OK to return to the Print dialog box.

5. Click OK to start printing.

   The print job is punched by the finishing device and delivered to the output tray.
Note: Each sheet is punched separately. When sheets are stacked, the holes may not line up exactly.

You can increase the left or top margin to provide additional space for hole punches by using the Gutter feature. For further details, refer to Gutter on page 5-4.

**Separation**

When multiple copies of a print job are printed, they can be difficult to separate in the output tray. The Separation feature stacks copies so that one can be clearly distinguished from another. Available options are:

- **Offset jobs** physically shifts each print job in the output tray.
- **Rotate copies** stacks each copy of a print job at right angles in the output tray.

**Rotate Copies**

Rotate copies stacks each copy of a print job at right angles in the output tray.

This feature requires the following:

- Paper size selections are limited to Letter, A4, 16K, or B5 (JIS).
- The selected paper size must be loaded into two paper sources, one horizontally and one vertically.
- The print job must contain multiple pages and be specified to print multiple copies.

1. From the application’s Print dialog box, open Properties. (Select Print from the File menu, and select Properties.)
2. In the Basic tab, under Destination, select an option that is not a finishing tray, for example: Top tray (face-down)
3. Select a number of copies greater than 1.
4. Click the Finishing tab, then select Separation. The Rotate copies option is selected.
5. Click OK to return to the Print dialog box.
6. Click OK to start printing.

Your print job is stacked in the output tray with each copy alternating horizontally and vertically.

**Offset Jobs**

Offset jobs physically shifts each print job in the output tray. This feature requires an optional finishing device such as an Internal finisher or 1000-sheet finisher. For further details, refer to Installing Optional Devices on page 2-1.

Note: To ensure consistent offset stacking, all users printing to the same printing system should select Offset jobs as the default setting. For further details, refer to Printer Properties on page 2-1.
1 From the application’s Print dialog box, open Properties. (Select Print from the File menu, and select Properties.)

2 In the Basic tab, under Destination, select a face-down finishing tray, such as Finishing tray or Finishing tray (face-down).

3 Click the Finishing tab, then select Separation. The Offset jobs option is selected.

4 Click OK to return to the Print dialog box.

5 Click OK to start printing.

Your print job is stacked in the output tray, offset from other jobs in the same tray.
6 Imaging

The Imaging tab contains options for print job Quality and Grayscale for print jobs.

Print Quality

1. From the Print dialog box of the application, click Properties.
2. In the Properties dialog box, click Imaging.
3. Select a Print quality from the list.
4. If you select Custom as the Print quality, next to the list click Custom Quality to open the Custom Quality Settings dialog box.

<table>
<thead>
<tr>
<th>Print Quality Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>High quality</td>
<td>Uses the highest printing system resolution.</td>
</tr>
<tr>
<td>Proof (monochrome printers only)</td>
<td>Uses the second highest printing system resolution.</td>
</tr>
<tr>
<td>EcoPrint</td>
<td>Makes text and graphics appear lighter in the printed job.</td>
</tr>
<tr>
<td>Custom</td>
<td>Choose your own combination of settings for Resolution, Kyocera Image Refinement and EcoPrint.</td>
</tr>
</tbody>
</table>
Custom Print Quality Settings

You can select one or more Custom Quality Settings:

- Resolution
- Kyocera Image Refinement
- EcoPrint

These settings can extend the life of toner cartridges by adjusting print resolution to reduce the amount of toner used.

<table>
<thead>
<tr>
<th>Custom Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution (monochrome printers only)</td>
<td>The number of dots printed in one inch. At higher resolutions more detail appears in the print job. Select Fast 1200 mode, 600 dpi, or 300 dpi.</td>
</tr>
<tr>
<td>Kyocera Image Refinement</td>
<td>Smoothes the outlines of text and vector graphics.</td>
</tr>
<tr>
<td>EcoPrint</td>
<td>Makes text and graphics appear lighter in the printed job.</td>
</tr>
</tbody>
</table>

EcoPrint

From the Imaging tab, click Print Quality > Custom. Click Custom Quality to view the Custom Quality Settings dialog box. EcoPrint changes toner saturation, making the entire image, text and graphics, appear lighter in the printed job. The actual amount of toner used depends on the printing system model, the type of data printed (text, graphics, or both), and whether it is monochrome or color. EcoPrint does not increase print speed.

Fonts

The Fonts feature lets you specify how TrueType fonts are sent to the printing system. The chosen method affects the speed and quality of the print job.

Note: All of Kyocera's device fonts are TrueType fonts; do not disable them in the driver.
1 Click **Fonts** to open the **Font Settings** dialog box.

![Font Settings Dialog Box]

2 Select one of the methods for sending TrueType fonts, and then click **OK** to save your selection:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Download as outlines</strong></td>
<td>Best suited for large documents or print jobs using multiple fonts and font sizes. Print speeds are faster because of the optimization features in this setting. The repetition of similar font data sent to the printing system is reduced, thereby increasing the print speed. Print speed cannot be increased when using Asian fonts such as Japanese, Chinese, and Korean, because of the large amount of font information used for these particular fonts.</td>
</tr>
<tr>
<td><strong>Allow native download</strong></td>
<td>Improves text quality and increases print speed by converting TrueType fonts to Adobe Type 42 font format. This feature is available when KPDL is selected in the <strong>PDL Settings</strong> dialog. For further details on changing the page description language, refer to <strong>PDL Settings</strong> on page 2-5.</td>
</tr>
<tr>
<td><strong>Download as bitmaps</strong></td>
<td>Bitmap downloading provides more detail, however it creates large file sizes. For print jobs with very small fonts (point size 1-4), user-defined fonts, or Asian fonts.</td>
</tr>
</tbody>
</table>
| **Substitute with device fonts** | System fonts and device fonts are automatically matched based on typeface name. To match a specific device font with a system font, select **Substitute with device fonts**, then click **Fonts** to open the **Font Substitution** dialog box. Select under these circumstances:  
  - To increase print speed and efficiency.  
  - To change a font found throughout a large document. This selection replaces the old font with the desired font. |

**Note:** GDI compatible mode does not support **Substitute with device fonts**. For further details on GDI compatible mode see page 2-6.
Font Substitution

With Substitute with device fonts selected as the font setting, click Fonts to open the Font Substitution dialog box.

The System fonts list shows the fonts installed on your computer. The printing system fonts are listed in the Available device fonts list. Select the system font, and then the available device font to be substituted. If the device font does not have similar font characteristics to the system font, character spacing in the document does appear incorrect.

Disable Device Fonts

In some cases, the printing system substitutes fonts even if you send the TrueType fonts as outline fonts or bitmap images. Select Disable device fonts to prevent substitution of device fonts for TrueType fonts.

When printing with Autodesk or Adobe applications and Microsoft Office versions older than Office 2000, select Disable device fonts to overcome device font limitations with these applications. Device fonts are normally visible in application font lists as printer icons next to the font name, unless there are equivalent system fonts, in which case the “TT” TrueType icon remains.

This option also improves portability of printable data. (If cleared, device fonts may not match when sent to a different printing system.)

The Substitute with device fonts option is disabled if Disable device fonts is selected.

Graphics

From the Imaging tab, click Graphics to open the Graphics Settings dialog box. Choose your graphics settings, and then click OK to save your selections. See below for descriptions of graphics settings options.

Note: Some options are available only when a specific PDL is selected. For further details on changing the page description language, refer to PDL Settings on page 2-5.
**Pattern Scaling**

Adjust the pattern scaling to improve visual compatibility between screen and print output.

If printed patterns and fills do not match the appearance of that on the screen, use this feature to select a different print density.

<table>
<thead>
<tr>
<th>Pattern Scaling Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Auto</strong> (default setting)</td>
<td>In most cases, this option prints patterns and fills to match the on-screen appearance.</td>
</tr>
<tr>
<td><strong>Coarse</strong></td>
<td>Prints patterns and fills with the fewest number of lines, patterns, or dots. Coarse is the same as Auto when PCL XL or PCL 5e is selected in the PDL Settings dialog box.</td>
</tr>
<tr>
<td><strong>Medium</strong></td>
<td>Prints patterns and fills with a greater number of lines, patterns or dots than the Coarse setting. Medium is the same as Auto when KPDL is selected in the PDL Settings dialog box.</td>
</tr>
<tr>
<td><strong>Fine</strong></td>
<td>Prints patterns and fills with the greatest number of lines, patterns, or dots. Printed patterns and fills may appear more dense than the on-screen appearance.</td>
</tr>
</tbody>
</table>

**Inversion Options**

Inversion options are available when KPDL is selected in the PDL Settings dialog box.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Reverse image</strong></td>
<td>Prints images like a photo negative, reversing black and white areas of the image.</td>
</tr>
<tr>
<td><strong>Mirror print</strong></td>
<td>Prints the page content backwards, as it would appear in a mirror image.</td>
</tr>
</tbody>
</table>

**Optimization**

Optimization selections are available when KPDL is selected in the PDL Settings dialog box.

<table>
<thead>
<tr>
<th>Optimization Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Fast printing</strong></td>
<td>Delivers images in binary format. Fast printing decreases spool size and increases print speed. Use it for most everyday printing needs.</td>
</tr>
<tr>
<td><strong>Document portability</strong></td>
<td>Creates a PostScript file in ASCII text encoding. Unlike the binary format created in Fast printing, the ASCII text created with this selection can be edited.</td>
</tr>
</tbody>
</table>
Halftone Screen

An experienced user can adjust Halftone Screen settings to create shades of gray in graphic images. The Halftone Screen process breaks down the image into dots. Larger dots spaced close together create darker shades, and smaller dots spaced farther apart create lighter shades. Shading can be varied by adjusting the number of rows of dots, the angle at which rows of dots are placed, and the shape of the dots.

Halftone Screen is available only when KPDL is selected in the Device Settings tab, in PDL Settings. If GDI compatible mode is selected in the PDL Settings dialog box, Halftone Screen is unavailable.

1. From the Graphic settings dialog box, click Halftone Screen.

2. Clear the Use printer's default screens check box.

3. Select from the list for each option, or enter the values:

<table>
<thead>
<tr>
<th>Halftone Screen Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ink</td>
<td><strong>Black</strong> is the only available ink color in the printed output.</td>
</tr>
<tr>
<td>Frequency</td>
<td>Number of rows of dots per inch or centimeter. Enter a numeric value in the Frequency box, and select lines/inch or lines/cm.</td>
</tr>
<tr>
<td>Angle</td>
<td>Select the angle at which rows are aligned. An angle is measured in degrees, ranging from -180 to +180.</td>
</tr>
</tbody>
</table>
Use the Grayscale options to adjust the appearance of graphics and text produced. Grayscale adjustment settings let you change the Brightness and Contrast of graphics. Grayscale adjustment settings are useful if graphic images are printing too light, too gray, or too dark. Text remains unaffected.

1 Click Adjustment to open the Adjustment Settings dialog box. A preview image in the dialog box illustrates any brightness and contrast changes.

2 Drag the Brightness slider right to lighten, or left to darken the graphic images of the print job. You can also change brightness by entering a numeric value in the text box at the right. The brightest setting is +100; the darkest is -100. Zero is the default mid-level setting. Adjusting brightness is useful when graphic images are printing too dark or too light. Text remains unaffected.

3 Drag the Contrast slider right or left to increase or decrease proportion of light to dark in the graphic images of the print job. A high contrast setting decreases the grayscale spectrum, making light grays lighter and dark grays darker. A low contrast setting increases the grayscale spectrum, making light grays darker and dark grays lighter. You can also change contrast by entering a numeric value in the text box at the right. The highest contrast setting is +100; the lowest is -100. Zero is the default mid-level setting. Adjusting contrast is useful if graphic images are printing too gray, or too black and white. Text remains unaffected.

---

**Halftone Screen**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shape</td>
<td>Select the shape of the halftone dot. The choice for the best halftone shape depends on the pattern and number of colors for your image.</td>
</tr>
<tr>
<td>Ellipse</td>
<td>Resists optical jump, which is when areas of an image that should be smooth suddenly become darker. An ellipse shape provides a smoother gradation of tones. Choose for images with dark areas.</td>
</tr>
<tr>
<td>Round</td>
<td>Resists moiré formation and dot gain. Moiré formation is an unintended pattern that occurs when two or more colors are printed at the wrong angles. The correct angles depend on the number of colors being printed. Dot gain is when the halftone dots increase when printed, causing a moiré pattern. Choose for images with light tints and highlighted areas.</td>
</tr>
<tr>
<td>Line</td>
<td>Used for special effect. You can change the effect by selecting a different Angle.</td>
</tr>
<tr>
<td>Increase accuracy of screens</td>
<td>Uses a very precise halftone screen which provides better print quality, but may increase printing time.</td>
</tr>
</tbody>
</table>
7 Publishing

This section describes the Cover mode, Page insert, and Transparency interleaving features of the printer driver. When these options are used with the MP tray, cassette mode (the default setting), must be set. For further details, refer to the printing system's Operation Guide.

- Cover mode: Adds a front or back cover to your document.
- Page insert: Inserts blank or printed pages before pages in your document.
- Transparency interleaving: Inserts a blank or printed page between transparencies.

Printing with Covers

For your document's front cover or front and back covers, you can insert and print on paper that is a different weight or color than the paper for the body of the document. You can also specify cover printing when completing booklet printing settings. The paper used for printing the document body is specified in the Paper settings in the Basic tab of the Properties dialog box. The source of the cover paper is specified by adjusting the Media for cover settings in the Publishing dialog box. You can also print on the covers.

To print using the Front inside or Back outside options in the Basic tab, you must select Print on both sides.

Although Cover mode and Page insert may be used simultaneously, they cannot be used with Transparency interleaving (described in Transparency Interleaving on page 7-6).

For further details on printing with covers in the booklet printing settings, refer to Booklet Printing on page 4-2.

1 From the application's Print dialog box, open the Properties. (Select Print from the File menu and select Properties.)
In the **Properties** dialog box, click the **Publishing** tab.

Select the **Cover mode** check box. Select from the page arrangements described in the table below.

### Cover Printing Options

<table>
<thead>
<tr>
<th>Check Box Selection</th>
<th>Cover Insertion Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Front</td>
<td>Inserts a blank front cover.</td>
</tr>
<tr>
<td>□ Front</td>
<td>Prints on the outside surface of the front cover.</td>
</tr>
<tr>
<td>□ Front Outside</td>
<td></td>
</tr>
<tr>
<td>□ Front Inside</td>
<td>Prints on the inside surface of the front cover.</td>
</tr>
<tr>
<td>□ Front Outside</td>
<td>Prints on the outside and inside surfaces of the front cover.</td>
</tr>
<tr>
<td>□ Front Inside</td>
<td></td>
</tr>
<tr>
<td>Check Box Selection</td>
<td>Cover Insertion Type</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>Front and Back</td>
<td>Inserts blank front and back covers.</td>
</tr>
<tr>
<td>Front and Back</td>
<td>Prints on the outside surface of the front cover and inserts a blank back cover.</td>
</tr>
<tr>
<td>Front and Back</td>
<td>Prints on the inside surface of the front cover and inserts a blank back cover.</td>
</tr>
<tr>
<td>Front and Back</td>
<td>Prints on both sides of the front cover and inserts a blank back cover.</td>
</tr>
<tr>
<td>Front and Back</td>
<td>Prints on the inside surface of the back cover and inserts a blank front cover.</td>
</tr>
</tbody>
</table>
From the Media for cover list, select the media type or source cassette for the front and back covers. When you choose the media type, a source cassette matching that media is automatically selected.  

**Note:** Heavy, thin, or other special papers must be supplied from the MP tray.

2. Load the paper for the front and back cover in the paper cassette selected in step 1.

3. Click OK to return to the Print dialog box.

4. Click OK to start printing.

### Page Insert

You can insert a preprinted page or a page of a different paper type before a designated page. You can also print on the inserted paper. Using the standard duplex unit, you can also print on the reverse of the inserted paper.
Although the Page insert and Cover mode may be used simultaneously, they cannot be combined with Transparency interleaving (described in Transparency Interleaving on page 7-6).

**Insert Page Printing**

1. From the application’s Print dialog box, open the Properties. (Select Print from the File menu and select Properties).

2. In the Properties dialog box, click the Publishing tab.

3. Select the Page insert check box. Select the option corresponding to your desired page arrangement as shown in the table below. To print on both the front and back of the inserted page, enable the Print onto front and Print onto back check boxes.

<table>
<thead>
<tr>
<th>Check Box Options</th>
<th>Page Insertion Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>☑ Page insert</td>
<td>Inserts a blank page before the second page.</td>
</tr>
<tr>
<td>☑ Page insert</td>
<td>Prints on the front surface of the inserted page.</td>
</tr>
<tr>
<td>☑ Print onto Front</td>
<td></td>
</tr>
<tr>
<td>☑ Page insert</td>
<td>Prints on the inside surface of the inserted page.</td>
</tr>
<tr>
<td>☑ Print onto Back</td>
<td></td>
</tr>
</tbody>
</table>
Adjust Media Combination Settings

1 Enter the page number to insert. A page is inserted between the page number you entered and the page before it. For duplex printing without printing on the cover, you can designate for pages to be inserted starting with page 2 and ending on page 255. For duplex printing and if you check print cover front and back, then the range is 3 to 255. If simplex printing, the range is from 2 to 511.

2 To designate several pages in the document for insertion, enter a comma (,) to separate them. For a series of insertions in a range of pages, use a hyphen (-). For example, to insert a page before pages 5, 11, 12, 13, and 18, enter [5,11-13,18].

3 From the Media for page list, select the media type of the inserted page or the source paper cassette. When you choose the media type, a source cassette that matches that media is automatically selected. Heavy, thin, or other special papers must be supplied from the MP tray.

4 Click OK to return to the Print dialog box.

5 Load the paper into the paper cassette.

6 Click OK to begin printing.

Transparency Interleaving

Transparency interleaving inserts a page between each transparency in a print job to prevent damaging the transparencies. This function is only available when printing on transparencies supplied from the MP tray. On these inserted pages you can print the same content as for the transparencies.

Transparency interleaving cannot be used together with Cover mode or Page insert.

Transparency Interleaving Method

1 From the application’s Print dialog box, open the Properties. (Select Print from the File menu and select Properties.)

2 If the Source and Media type lists have been combined in the Compatibility Settings dialog box, select Auto (Transparency).
If the Source and Media type lists have not been combined, from the Media type list, select Transparency.

3 Click the Publishing tab.

4 Select the Transparency interleaving check box. To print the transparency content on the inserted pages as well, select the Print onto backing check box.

5 From the Media for backing list, select the media type of the backing sheet or the source paper cassette. When you choose the media type, the source cassette where that media is loaded is automatically selected.

6 The printing system’s operation panel prompts you to load transparencies into the MP tray, and, if necessary, load backing paper into the selected cassette.

7 Click OK to begin printing.
8 Job

This feature lets you store print jobs in the standard Hard disk so that you can print them again later from the printing system's operation panel.

Job Storage (e-MPS)

The Job tab offers a variety of features, as listed below. Not all features are available on all printing systems. The Job tab only shows the features that are available on your particular printing system.

<table>
<thead>
<tr>
<th>Printer Driver Menu Options</th>
<th>Function</th>
<th>Job Deletion after Printing</th>
<th>Access Code</th>
<th>Panel Message (Category)</th>
<th>Default number of copies printed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom Box</td>
<td>Stores print jobs for later printing from the operation panel.</td>
<td>User can specify how long job is saved</td>
<td>Yes</td>
<td>Document Box&gt;</td>
<td>Same as for original job</td>
</tr>
<tr>
<td>Quick Copy</td>
<td>Prints all copies of a job and then saves it on the printing system’s hard disk so it can be reprinted from the printing system’s operation panel.</td>
<td>Saved until printing system power is turned off</td>
<td>No</td>
<td>Menu&gt;e-MPS&gt; Quick Copy</td>
<td>Same as for original job (adjustable)</td>
</tr>
</tbody>
</table>
Sometimes the application settings are given priority over the printer driver settings, causing a change in the output method.

If you select one of the Job options, the hard disk icon appears in the lower corner of the Preview image.

### Custom Box

Custom boxes are created on the printing system’s hard disk and assigned to multiple users. Jobs saved in a Custom box can be printed later from the printing system’s operation panel.

100 Custom boxes are set up on the printing system’s hard disk at installation. The maximum number of Custom boxes is 1000.

When setting up a Custom box on the hard disk, you have the option of having jobs deleted after printing or of saving jobs for 1-31 days.
Register a Custom Box

Before you can send a document to a Custom box, you must register a Custom box at the printing system’s operation panel.

1. At the printing system’s operation panel, press the **Document Box** key.

2. A list of Custom boxes that are already registered, if any, appears on the operation panel. Press the **Edit Box** key and then on the next screen press the **Add** key.

3. To assign the box number, press the Box Number **Change** key. Use the + and - keys to enter the box number and then press **OK**.

4. To give the box a name, press the Box Name **Change** key. Enter a name using the alphanumeric keypad and then press **Ok**.

5. Press the Box Password **Change** key, then press the Password key and enter the password using the alphanumeric keypad, and then press **OK**.

6. Next, press **Confirm Password** and reenter the password and then press **OK**.

7. Press **OK** again to finish entering the password.

8. If you would like to restrict the size of Custom boxes that can be created, press the Usage Restriction **Change** key and then use the + and - keys to enter a number, and then press **OK**.

9. If you would like to set a time limit on how long the hard disk saves print jobs in this box, press the Auto File Deletion **Change** key. Use the + and - keys to set the number of days to save jobs, and then press **OK**.

10. When you have completed the Custom box settings, press the **Register** key.

Set Up Custom Boxes in the Driver

Use this procedure to set up Custom boxes in your printer driver (on your computer) that match the custom boxes registered at the printing system’s operation panel.

1. Click **Start** in the Windows task bar, and click **Printers and Faxes** to open the **Printers and Faxes** window.

2. Right-click the icon for your printing system in the **Printers and Faxes** window. A list appears.
3 Click **Properties** in the list. The **Properties** dialog box appears. Click the **Device Settings** tab, and double-click **Hard disk**.

![Properties dialog box]

4 The **Hard Disk Settings** dialog box appears. Click **Add**. In **Box number**, type in a four-digit number between 0001 and 1000.

![Hard Disk Settings dialog box]

5 Type a name in the **Box name** text box. The name can be up to 32 characters in length.

6 Type a **User name**.

7 To share a box, select **Shared box**.

8 To set a password for the Shared box, select **Require password** and type a password.

9 Click **Add**.

To assign multiple Custom boxes, repeat the steps for setting up custom boxes in the driver. When finished, click **OK** to close the **Hard Disk Settings** dialog box.
To delete a Custom box that you created, select the Custom box from the Box Number list and click Delete.

**Import and Export a Custom Box List**

This section explains how to import and export Custom box lists. You can save the list of Custom boxes created in the previous section onto your personal computer or network. Once saved, the list can be imported into other printer drivers.

**Export**

1. Click Start in the Windows task bar, and click Printers and Faxes to open the Printers and Faxes window.
2. Right-click the icon for your printer in the Printers and Faxes window. A list appears.
3. Click Properties in the list. The Properties dialog box appears. Click the Device Settings tab, and double-click Hard disk.
4. The Hard Disk Settings dialog box appears. Click Export.
5. The Export Custom Box List dialog box appears. Select a save location from the Look in list.
6. Type a File name and click Save.
7. Click OK to close the Properties dialog box.

**Import**

1. Click Start in the Windows task bar, and click Printers and Faxes to open the Printers and Faxes window.
2. Right-click the icon for your printing system in the Printers and Faxes window. A list appears.
3. Click Properties in the list. The Properties dialog box appears. Click the Device Settings tab, and double-click Hard disk.
4. The Hard Disk Settings dialog box appears. In Box number, type in a four-digit number between 0001 and 1000 and click Import.
5. The Import Custom Box List dialog box appears. Select the Custom box data file to import and click Open.
6. The Custom box list is opened and displayed in the Defined Custom Boxes area. Click OK to save the list. The imported list replaces all the Custom boxes that were already in the list.
Save Jobs in Custom Boxes

1 From the application’s Print dialog box, open the Properties dialog box, and click the Job tab.

2 Select Custom box and click Selection.

3 The Custom Box Settings dialog box appears.

If no Custom boxes have been created in the driver, the last two options are disabled. See Set Up Custom Boxes in the Driver on page 8-3 for instructions on adding a Custom box.

The options, and their behavior at print time are explained here:

**Use the specific box number** This option lets you type in the box number and password here instead of selecting from a list after you click Print (or OK, depending on the application you are printing from). To use this option, select Use the specific box number, type the box number and password, and then click OK.

**Prompt for box number** If this option is selected, at print time the driver asks for the box number and password.

**Display box number list** If you select this option, at print time the driver opens a dialog box with a list of Custom boxes to choose from. Select a box, type the password, and then click OK.

**Verify box number for each login user** At print time this option asks for a box number and password for each login user saved to a custom box. The box number...
and password must have been already added to the Custom box list. See *Set Up Custom Boxes in the Driver* on page 8-3 for instructions on adding a Custom box.

Make a selection, type in a box number and password if needed, and then click **OK**.

4. Click **OK** to close the **Properties** dialog box, and then click **Print**. The job is saved to the specified Custom box and held for printing.

**Print Jobs in Custom Boxes**

Jobs are printed from the printing system’s operation panel.

1. At the printing system’s operation panel, press the **Document Box** key.

2. A list of custom boxes appears. Select a box and press **Open**.

3. A list of documents saved in the custom box appears. To select a document to print, press the checkbox in the left hand column. A checkmark appears.

4. Press **Print**.

5. A window with printing options appears. Here you can select options like duplex, staple, and paper size. For complete information on print settings that can be set at the operation panel, see your printing system’s *Operation Guide*.

6. To print the document, press the **Start** key.

**Quick Copy**

After using the quick copy feature, a document can be reprinted from the operation panel.

1. In the **Properties** dialog box, click the **Job** tab.

2. Select the **Job storage (e-MPS)** check box, and then select **Quick copy**.

3. You can name the job for later reference when printing from the printing system’s operation panel. Under **Job name**, select **Application defined** for automatic naming by the application. Or, select **Custom** to type in a name of your choice. The name can be up to 79 characters.

   With **Application defined** (display application name and Job name) selected for Microsoft Word or Power Point jobs only, you can choose to display only the Job name, up to 32 characters, in the job list and at the operation panel message. Job name is the same as the document name. To remove the application name, select **Don’t use application name**.

4. Click **OK**.

5. When you **Print** from the application, the job is saved to the hard disk while the specified number of copies prints.
Print Additional Copies of Quick Copy Jobs

1 Press the Document Box key at the printing system's operation panel.

2 Press Job Box.

3 Press Quick copy/Proof and Hold.

4 Press Open.

5 If the user name is correct, press Open. Otherwise, press the ▼ or ▲ key until the correct name appears.

6 If the job name is correct, press Print. Otherwise, press the ▼ or ▲ key until the correct job appears.

7 Press the + or - key to specify the number of copies.

8 Press Start Print.

Delete Quick Copy Jobs

1 Refer to steps 1 through 5 in Print Additional Copies of Quick Copy Jobs on page 8-8.

2 If this is the correct job for deletion, touch DELETE. Otherwise, press the ▼ or ▲ key until the correct name appears.

3 Press YES to delete the job.

Proof and Hold

1 Open the Job tab as indicated in the instructions for Quick Copy on page 8-7. Select Proof and hold.

2 Name the job for future reference when printing from the printing system's operation panel.
   • If you select Application defined in Job name, the application automatically names the document.
   • In the Job name area, select Custom to type in a name of your choice. The name can be up to 79 characters in length.

3 Click OK.

When printing a Proof and hold job of multiple copies, only the first copy is printed and the remaining copies are saved. Follow the steps below after proofing the first copy.

Print the Remaining Copies of Proof and Hold Jobs

You can print the remaining copies of Proof and hold jobs following the same steps as for Print Additional Copies of Quick Copy Jobs on page 8-8. Use the keys at the printing system’s operation panel to proceed. When using the Proof and hold option, the number of copies shown is one less than the total due to the existing proof
copy. The printed jobs remain saved on the hard disk until the printing system is turned off. To delete jobs manually, use the same key sequences as explained in Delete Quick Copy Jobs on page 8-8.

**Private Print**

**Private print** jobs are saved to the hard disk for printing until a four-digit access code is entered. The saved jobs are deleted as soon as they are printed.

**Save a Private Print Job**

1. In the Job tab, select **Private print**.
2. Type in a four-digit number for the **Access code**.
3. You can name the job for later reference when printing from the printing system’s operation panel.
   - If you select **Application defined** in **Job name** the application automatically names the document.
   - In **Job name**, select **Custom** to type in a name of your choice. The name can be up to 79 characters in length.
4. Click **OK**.

**Print Private Print Jobs**

1. Press the **Document Box** key at the printing system’s operation panel.
2. Press **Job Box**.
3. Press **Private Print/Stored Job**.
4. Press **Open**.
5. If the user name is correct, press **Open**. Otherwise, press the ▼ or ▲ key until the correct name appears.
6. If the job name is correct, press **Print**. Otherwise, press the ▼ or ▲ key until the correct job appears.
7. Enter the four-digit access code created in **Private Print** on page 8-9.
8. Press the + or - key to specify the number of copies.
9. Press **Start Print**.

After printing, the job automatically deletes from the hard disk. To delete the job without printing it, follow the same procedure as in Delete Quick Copy Jobs on page 8-8.
Job Storage

The Job storage feature saves jobs on the hard disk for future printing, even if the printing system is switched off. You can also use access codes to restrict the printing of forms.

1 In the Job tab, click Job storage (e-MPS) and then select Job Storage.

2 Select the Access code check box and type in the desired four-digit access code. When you want to print the saved jobs, type in the access code on the printing system’s operation panel.

3 You can name the job for future reference when printing from the printing system’s operation panel.
   • If you select Application defined in the Job name box, the application automatically names the document.
   • To give it a name you create, in Job name, select Custom and type in the name of your choice. The name can be up to 31 characters in length.

4 Click OK. When you select print, the job is saved to the hard disk without printing.

Print Jobs Saved Using Job Storage

To print forms and other documents saved using Job Storage, follow the same steps as for Print Private Print Jobs on page 8-9.

The stored jobs remain saved even after the printing system is switched off. To delete them manually, follow the same steps as for Delete Quick Copy Jobs on page 8-8. When deleting jobs, you must type in the same access code as saved in the Job storage procedure.
**Job Name**

Select a name for your print job to use with Job storage features, or to display the name on the printing system's operation panel while the job is printing. This can help manage documents when multiple users are using the device at the same time. Select **Application defined** to allow the application to define the Job name or select **Custom** and type your own Job name, to a maximum of 79 characters.

With **Application defined** selected, select the **Don't use application name** check box to remove the application name from the job name in the operation panel message and in job storage features. The job name is easier to find in a job list. This feature is useful only when printing from Microsoft Word or PowerPoint.
9  Advanced

The Advanced tab contains special features that extend the capabilities of the printing system. Click the button at the left of the feature name to open a dialog box containing options for that feature.

- Prologue/Epilogue inserts PRESCRIBE printing system language commands into specified pages or locations of a print job.
- Watermark adds semitransparent text to a print job.
- Security Watermark adds watermark text and a background pattern to a print job. The text is nearly invisible when printed, but shows up if the printed document is photocopied.
- Enable Client Profile allows you to save custom profiles in your client driver or use the profiles on the server to apply with your print jobs.
- EMF Spooling allows you to return to your application while running a large print job.

Prologue/Epilogue

Prologue/Epilogue lets an experienced PRESCRIBE user insert one or more printing system language command files into specific locations of a print job. For example, a command file may contain a macro (series of commands called to accomplish a
specific task), settings for printing system emulation, an electronic form, or a graphic object such as a logo or signature.

You can add or delete command file names in the list, or select a file to edit.

- To insert a command file into the print job and enable the features in the Prologue/Epilogue dialog box, select a file name from the list.
- To disable Prologue/Epilogue features and clear selection of all command files, select [None] at the top of the file list. (To disable a particular command file, select the file, then select Unassigned.)

**Select Prologue/Epilogue File to Insert**

From the list, select the name of a command file to insert into the print job. (If no file names are visible in the list, you must click Add to browse for files on your computer or network to add to the list.) Selecting a file enables the insertion point options for that file in the dialog box.

**Add**

Click Add to browse your computer or network for command files. The files are plain text format and typically have a file name extension of either .txt or .log.

**Edit**

Select a file name in the list, then click Edit. Microsoft Notepad opens for editing the file text. To return to the Prologue/Epilogue dialog box, save any changes to the file and exit Notepad.

*Note:* Editing a file changes the original file in the computer or network directory.

**Delete**

Select a Prologue/Epilogue file name, then click Delete. In the message box, click Yes to confirm the deletion. To refuse the deletion, click No.

*Note:* The file name only is removed from the Prologue/Epilogue list. The original file itself is not deleted; it remains in the computer or network directory.
Insertion Point

Each file in the list can be assigned only one insertion point. Choose one of the following insertion point options:

Unassigned

The selected command file is not inserted into the print job. This is useful if the list contains several command files, and you want to print some but not others. Select Unassigned for the files you do not want to print.

**Note:** To disable all command files (thereby disabling the entire Prologue/Epilogue feature), select [None] at the top of the file list.

Beginning of the print job

The command file is inserted as the first page of the print job. The document starts printing on the second page.

End of the print job

The command file is inserted as the last page of the print job, which prints after the last page of the document.

**Note:** The following Start of the page and End of the page insertion point options are available only when PCL 5e is selected as the PDL (Page Description Language). For further details on changing the page description language, refer to PDL Settings on page 2-5.

Start of the page

The command file is inserted at the top of each page of the print job.

End of the page

The command file is inserted at the bottom of each page of the print job.

With Start of the page or End of the page selected, choose one of the following page options:

Only on odd pages

The command file is inserted into all odd-numbered pages.

Only on even pages

The command file is inserted into all even-numbered pages.

Pages

To insert the command file into specific pages, type individual page numbers separated by commas in the text box, or a page range separated by a hyphen.

For example, if you type 2 in the text box, the command file is inserted only into page 2. If you type 1, 3, 5-12 the command file is inserted into page 1, page 3, and pages 5 through 12.
If the Pages option is selected and you click OK without entering any numbers, you are prompted to specify page numbers.

**Watermark**

Use the Watermark feature to create, arrange, and print semitransparent text in the background of a document. You can choose one of four standard watermarks or create your own text. The preview area at the left of the dialog box shows how the watermark appears on a page. This is useful for viewing any adjustments you make to the appearance and location of the text.

**Select Watermark**

Select a watermark from the Select watermark list. The selection list contains four standard watermarks: Confidential 1, Confidential 2, Sample and Copy. For details on creating your own watermarks, see Add Watermark on page 9-5.

**Page selection**

Page selection options are enabled after a watermark is selected from the list. Choose one of the following:

- **All pages**
  The watermark prints on every page of the document.

- **First page only**
  The watermark prints only on the first page of the document.

- **All pages except first page**
  The watermark prints on all pages of the document except the first page.

- **Only on specified pages**
  To print the watermark only on specific pages, type individual page numbers separated by commas in the text box, or a page range separated by a hyphen.

  For example, if you type 2 in the text box, the watermark prints only on page 2. If you type 1, 3, 5-12 the watermark prints on page 1, page 3, and pages 5 through 12.
If the **Only on specified pages** option is selected and you click **OK** without entering any numbers, you are prompted to specify page numbers.

**Print onto front outside cover**

Select **Print onto front outside cover** to print the watermark on a separate front cover page before the document prints. This option is enabled when **Cover mode** is selected in the **Publishing** tab.

If **Cover mode** and **Front outside** are selected in the **Publishing** tab, the **Print onto front outside cover** option in the **Watermark** dialog box shows as selected, but is disabled. This is because cover printing is already enabled by the two **Publishing** tab selections.

In the **Publishing** tab you can also select different media for the cover than that used for the rest of the print job. For further details, see *Printing with Covers* on page 7-1.

**Add Watermark**

You can create your own custom watermarks with different fonts, styles, colors, sizes, positions, and angles. You can also set **Count** to have the watermark appear multiple times on the page.

1. Click **Add** to open the **Add Watermark** dialog box.

2. Type a descriptive name for your watermark in the **Watermark name** text box. The name can be different from the actual watermark text. After the new watermark is added, the name appears in the **Select watermark** list.

3. Type the text you want to print as a watermark in the **Watermark text** box. Your text appears in the preview area at the left of the dialog box.

4. To add the new custom watermark, click **OK**. To exit the dialog box without saving the watermark, click **Cancel**.

**Additional Text Options**

**Fonts**

Select a font for the new watermark from the **Font** list, and select a font style, color, and size.

In the **Count** box, type in the number of watermarks to appear on a page, from 1 to 20. Selecting a number greater than 1 in **Count** enables the **Spacing** option. Type in a number for the distance between multiple watermarks, in tenths of an inch or millimeters. The unit (inches or millimeters) is selected in the **User Settings** dialog box, accessed from the **Device Settings** tab. For further details on changing the unit, refer to *User Settings* on page 2-4.
Use the preview area and the **Position** or **Angle** features to adjust where the watermark prints on the page.

### Position

Click the position button to change the position of the watermark without changing the angle. Position the cursor anywhere in the preview area. Click and hold as you move the mouse, adjusting the watermark image as you want it to appear on the printed page.

The following options provide additional means for positioning watermark text:

**Centered [default]**: Places the center of the watermark text in the center of the page.

**User defined**: Select, and then use the x and y boxes to move the text from the center of the page:

- A positive x value moves the watermark text to the right.
- A negative x value moves the watermark text to the left.
- A positive y value moves the watermark text down.
- A negative y value moves the watermark text up.

### Angle

Click the **angle** button to change the angle of the watermark. Position the cursor anywhere in the preview area. Click and hold as you move the mouse, rotating the watermark image to as you want it to appear on the printed page.

The method of rotation is determined by selecting or clearing the **Rotate around center** check box at the far right of the dialog box. Select the check box to rotate text around its center; clear the check box to rotate text around its left end. You must select **User defined** in both **Angle** and **Position** to enable the **Rotate around center** option.

The following options provide additional means for positioning watermark text:

**Diagonal [default]**: Places the watermark at the default angle.

**User defined**: Select to change the angle from the default value. Type in the number for the angle you want. An angle is measured in degrees, ranging from 0 to 360.
**Edit Watermark**

The **Edit Watermark** feature lets you select an existing watermark and make changes to its appearance and properties. For standard watermarks, the **Watermark name** and **Watermark text** cannot be changed.

1. From the **Select watermark** list, select a watermark to edit.
2. Click **Edit** to open the **Edit Watermark** dialog box.
3. Make any adjustments you want to the watermark. For details on how to change watermark properties, refer to **Add Watermark** on page 9-5.
4. When you are finished editing, click **OK** to save any changes you made to the watermark. To exit the dialog box without saving the changes, click **Cancel**.

**Delete Watermark**

The **Delete** feature lets you delete custom watermarks that were added. The standard watermarks cannot be deleted.

1. From the **Select watermark** list, select a watermark to delete.
2. Click **Delete**.
3. In the message box, click **Yes** to confirm the deletion. To refuse the deletion, click **No**.

**Security Watermark**

**Security Watermark** is an optional feature that is available with some printing systems. Security Watermark adds watermark text and a background pattern to a print job. The text blends into the background pattern making it nearly invisible when printed. If the printed document is photocopied, the security watermark is visible. A security watermark can be used to help protect against unauthorized reproduction of documents, or simply to differentiate original documents from photocopies.

If Security Watermark is available for your printing system, the installation program offers the opportunity to install it during installation of the printer driver. If you have already installed the printer driver, you can install Security Watermark using the installation CD-ROM that came with your printing system.

The Security Watermark feature is accessed from the **Advanced** tab. To enable the button that opens the **Security Watermark** dialog box, **PCL XL** must be selected as the **PDL** (Page Description Language). To view or change PDL settings, in the
Windows Printers and Faxes folder right-click the icon for your printing system, and select **Properties**. Click the **Device Settings** tab, then click **PDL**.

To enable the **Security Watermark** feature, select a watermark from the list. You can choose one of four standard security watermarks, or create your own text. To disable the security watermark feature, at the top of the list select **[None]**. If **[None]** is selected, no security watermark is applied to the document, and all options in the dialog box are unavailable, except **Add**.

The preview area provides an idea of how the security watermark and background appears on a photocopied page. It is useful for viewing any adjustments made to the appearance of the text. Only a section of the preview page is displayed; it does not show how the entire page appears. The preview shows all security watermark settings except **Pattern shading**, **Text contrast**, **Overprint**, and **Print as footer also**.

Security watermark is available only when these driver features are set as follows:

- **Scaling** set to 100%
- **Print size** set to 100%
- **Gutter – Reduce Image to Fit** set to Off
- **Multiple pages per sheet** set to Off
- **Booklet** set to Off
- **Watermark** set to Off
- **Poster** set to Off
- **Resolution** set to 600 dpi
- **Kyocera Image Refinement** set to Off
- **EcoPrint** set to Off
- Monochrome **Brightness** and **Contrast** set to 0

The **Select security watermark** list is constrained to **[None]** if any of these settings are changed. The reverse also applies: if Security Watermark is set to anything other than **[None]**, the settings are constrained by the driver to the following values:

- **Scaling** set to 100%
- **Print size** set to the same size as **Page size**
- **Gutter – Reduce Image to Fit** set to Off
- **Multiple pages per sheet** set to Off (pages per sheet is set to 1)
- **Booklet** set to Off
• **Watermark** set to Off
• **Poster** set to Off
• **Print Quality - Custom** is constrained as follows:
  • **Resolution** set to 600 dpi
  • **Kyocera Image Refinement** set to Off
  • **EcoPrint** set to Off
• **Monochrome Brightness** and **Contrast** set to 0.

**Select Security Watermark**

Select a watermark from the **Select security watermark** drop-down list. The selection list contains four standard security watermarks: **Confidential 1**, **Confidential 2**, **Sample**, and **Copy**. For details on creating your own watermarks, see **Add Security Watermark** on page 9-10.

**Note:** The quality and effectiveness of the printed and photocopied security watermark is dependent on the particular printing system and the settings used. Before printing a security watermark, it is necessary to adjust the calibration and print calibration pages. It is also necessary to adjust the calibration, then print calibration pages, whenever certain changes are made to the printing system or security watermark settings. See **Adjust Calibration** on page 9-12 for more information on how to perform these important steps.

**Page Selection**

**Page selection** options are enabled after a security watermark is selected from the list. Choose one of the following:

**All pages**

The security watermark prints on every page of the document.

**First page only**

The security watermark prints only on the first page of the document.

**All pages except first page**

The security watermark prints on all pages of the document except the first page.

**Only on specified pages**

To print the security watermark on specific pages, type individual page numbers separated by commas in the text box, or a page range separated by a hyphen.

For example, if you type **2** in the text box, the security watermark prints only on page 2. If you type **1, 3, 5-12** the security watermark prints on page 1, page 3, and pages 5 through 12.

If the **Only on specified pages** option is selected and you click **OK** without entering any numbers, you are prompted to specify page numbers.

**Print onto front outside cover**

Select this option to print the security watermark on the front cover page. **Print onto front outside cover** is enabled when **Cover mode** is selected in the **Publishing** tab.
When printing is specified for the first page under Page Selection and Front outside is selected in the Publishing tab, Print onto front outside cover is automatically selected by the driver. (Even though the check box shows as selected, the option is disabled.)

If you want, in the Publishing tab you can also select different media for the covers than that used for the rest of the print job. For more details on Cover mode, see the Publishing chapter.

Add Security Watermark

You can create your own custom security watermarks with different fonts, styles, colors, sizes and angles. You can also make changes to the footer, footer position, background pattern, pattern shading, and text contrast. A maximum of 26 security watermarks can be added (in addition to the existing standard security watermarks).

Note: The Add button is unavailable when the number of security watermarks reaches the maximum of 30. You must delete items to make the Add button available again.

1 Click Add to open the Add Security Watermark dialog box.

2 Type a descriptive name for your watermark in the Security watermark name text box. The name can be different from the actual watermark text, but the name cannot be the same as one of the standard security watermark names. After the new watermark is added, its name appears in the Select security watermark drop-down list.

If you type the same name as a previously added security watermark, when you try to add the new watermark the driver prompts you for a decision to replace the one that already exists. Click Yes to replace the existing security watermark with the new one, or click No to cancel the Add action.

If you do not type a name, and the name text box is left blank, the driver prompts you to type a name. A security watermark cannot be saved with a blank name.

3 Up to three lines of text can be printed as a security watermark. Though the text lines (Line 1, Line 2, Line 3) are all optional, at least one of the lines must contain text.
To leave a text line blank, select [None] from that line’s drop-down list.

With User Defined selected from the Line text drop-down list, type the text you want in the text box next to the drop-down list. The maximum length of each line of text is 39 characters. As you type, your text appears in the preview pane at the left.

As an alternative to creating your own security watermark text, you can choose one of the following selections from the list. These options direct the printing system to retrieve information from the computer or printer driver to print the security watermark:

- Computer name
- Date and time
- Job name
- Mac address
- User name
- IP address
- Time
- Date
- Job ID

For date, time, and job selections, only a label for the selection appears in the preview panel. When the job is printed, the actual date, time or job information prints as the security watermark text.

4. To add the new custom security watermark, click OK. To quit the dialog box without saving the watermark, click Cancel.

**Additional Options**

**Fonts**

Select a font for the new watermark from the Font list. The Security Watermark feature uses only TrueType fonts. Select a font Size and Style. To adjust the Angle of the text on the page, select from the list. An angle is measured in degrees, ranging from 0 to 180. The default is 45 degrees.

**Print as Footer Also**

Select this option to print the first available line of text (in the Line 1, Line 2, or Line 3 text boxes) as a footer on the document page. Select Left, Center, or Right to position the text in the footer.

Since the actual security watermark text may not be visible on the document original, the footer can be useful for reproducing the text visibly in an inconspicuous place at the bottom of the page.

**Outline Text**

This option produces an effect on the photocopied page that is the reverse of the standard result. If the check box for Outline text is cleared (the standard printing option), the text is the darkest, most visible part of the photocopy. If selected, the background is the most visible part, creating an outline around the text which makes the text appear white. The default setting for Outline text is On.

**Watermark Color**

Select a Watermark color from the drop-down list for printing the security watermark text and background. The default is Black.

**Background Pattern**

Select a Background Pattern from the drop-down list for printing the security watermark background.
Available background pattern choices are:

- Wave
- Leaf
- Diamond
- Lattice
- Tile
- Plaid
- Square
- Crystal

**Overprint**

Select **Overprint** to print the security watermark over the document content, leaving the content visible. The effect is the security watermark seems blended in with the document content. This is useful for applications such as Microsoft Power Point and Internet Explorer, where the document content fills the entire page. If the **Overprint** check box is cleared, the security watermark is covered with the document content.

In the **Device Settings, PDL Settings** dialog box, if **GDI compatible mode** is selected, then Overprint is selected automatically.

**Adjust Calibration**

Use this option to set and make adjustments to the **Pattern shading** and **Text contrast** for each individual security watermark. You can print sample calibrations to help you determine the appearance of the security watermark.

The quality and effectiveness of the printed and photocopied security watermark is dependent on the particular printing system and the settings used. Before printing a security watermark it is necessary to adjust the calibration, and then print calibration pages.

Calibration should be adjusted (and calibration pages printed) under these circumstances:

- Before using the Security Watermark feature the first time for each standard or custom security watermark.
- When the toner is replaced.
- After periods of heavy printing activity.
- When the physical printing device is replaced.
- After changing the background pattern.

1. Click **Adjust Calibration** to open the **Calibration Adjustments** dialog box.

2. **Pattern shading**: Select Light, Normal, or Dark from the list for the shading density to apply to the pattern background. The default is Normal.

3. **Text contrast**: Select a contrast level from the list to specify text darkness in relation to the background pattern. Contrast 1 is the lightest against the background, and Contrast 9 is the darkest. The default value for **Text contrast** varies with the printing system model.
4 **Print sample**: Click to print a sample page of the selected text contrast and background shading density. For comparison, the page also includes other text contrast options. Your settings are identified in the **Current selection** box bordered in black.

5 For best results, print three separate sample pages using each of the **Pattern shading** selections, **Light**, **Normal** and **Dark**. This provides the best range of choices for **Pattern shading** and **Text contrast** settings.

6 To ensure the security watermark prints and photocopies correctly, select the combination of **Pattern shading** and **Text contrast** settings where the text is the most nearly invisible.

7 To save your calibration adjustments, click **OK**. To quit the dialog box without saving new adjustments, click **Cancel**.

**Edit Security Watermark**

The **Edit Security Watermark** feature lets you select an existing watermark and make changes to its appearance and properties. For standard security watermarks, the **Security watermark name** and **Line 1, 2, and 3** text cannot be changed.

1 From the **Select security watermark** drop-down list, select a watermark to edit.

2 Click **Edit** to open the **Edit Security Watermark** dialog box.

3 Make any adjustments you want to the security watermark. For details on how to change security watermark properties, see **Add Security Watermark** on page 9-10.
When you are finished editing, click **OK** to save any changes you made to the security watermark. To quit the dialog box without saving the changes, click **Cancel**.

### Delete Security Watermark

The **Delete** option lets you remove a custom security watermark that was previously added. The standard security watermarks cannot be deleted. If the watermark selected in the list is one of the standard security watermarks, the **Delete** button is disabled.

1. From the **Select security watermark** list, select a watermark to delete.
2. Click **Delete**.
3. In the message box, click **Yes** to confirm the deletion. To refuse the deletion, click **No**.

### Security Settings

Security watermark can be installed separately or as part of the Security settings plug-in, which also includes PrintID tracker.

#### Security Watermark in Security Settings

To use Security watermark in Security settings:

1. In the **Advanced** tab, click **Security Settings** to open the **Security Settings** dialog box.
2. Under **Select security settings**, select **Security Watermark**.

**Note:** In Security settings, the **Add** and **Edit** options are slightly different for Security Watermark, as noted below. For details on all feature options, see **Security Watermark** on page 9-7.

The following additional options are available in the Add and Edit dialog boxes only for Security Watermark as a component of the Security Settings package:

**Image** Select to use an image for the Security watermark. Type the path and file name (.MIE), or click **Browse** to find a valid image file.

**Text** Select to use text for the Security watermark.

### PrintID Tracker

PrintID tracker lets you embed user and print job information in the document, such as user name, date and time, and IP address, to hinder unauthorized printing of sensitive documents. The PrintID Reader utility can scan and read a document embedded with PrintID tracker information, and then trace it back to its source. This can help prevent leakage of sensitive printed information. If people know that print jobs can be traced back to them, this helps prevent them from printing sensitive information. PrintID tracker is available with the Security settings plug-in module.

In **Device Settings, PDL**, select **PCL XL** to make this feature available.
The administrator can lock PrintID tracker so that all printed documents are embedded with ID information. See Lock PrintID Tracker on page 9-16.

To use PrintID tracker:

1 In the Advanced tab, click Security Settings to open the Security Settings dialog box.

2 Under Select security settings, select PrintID Tracker.

With PrintID tracker selected, the following options are available in the Security Settings dialog box:

Select ID: Displays a list of default and custom IDs. A maximum of 30 IDs can be saved. Select an ID from the list.

Preview: Illustrates the color and mode of the selected ID.

Add: To open the Add ID dialog box and create custom IDs, click Add.

Edit: Select an existing ID and click Edit to open the Edit ID dialog box.

Delete: To remove a custom ID from the list, select it and click Delete. Default IDs cannot be deleted.

Page Selection

Page selection options let you indicate which page or pages to print the ID.

Choose one page option for the ID:

All pages: Prints the ID on all pages.

First page only: Prints the ID on the first page.

All pages except first page: Prints the ID on all pages after the first page.

Only on specified pages: Prints the ID on a specified number of individual pages separated by a comma, and/or a range of pages separated by a dash.

Print onto front outside cover: Prints the ID on the front and/or back cover pages. Cover mode in the Publishing tab must also be specified for the print job. To use, select the Publishing tab, then select Cover mode.

ID settings: Displays the optional settings selected for the current ID. Optional settings can be selected in the Add ID and Edit ID dialog boxes.

Add Edit ID

You can create a custom ID or edit an existing ID.

With PrintID tracker selected in the Security Settings dialog box.

1 Click Add to create a new ID.

2 Select an existing ID from the Select ID list and click Edit to change settings. The name and embedded information cannot be changed for default IDs.

The following options are available in the Add ID and Edit ID dialog boxes:
**ID name:** Type a descriptive name for the new ID, up to 39 characters. Once added, it appears in the ID selection list in the Security Settings dialog box.

**Embedded information:** Select optional text to include in addition to default ID information. Select from the following options:

- **User defined:** Type custom text, up to 39 characters.
- **Job name** Include the default job name. For some models, the job name can be selected in the Job tab.
- **IP address:** Include the computer’s IP address.

**Pattern size:** Select the density of the printed pattern:

- **Fine:** A lighter background that makes the printed document easier to read.
- **Coarse:** A darker background and higher likelihood of detection.

**Color:** Select the color for the printed pattern. For monochrome models, Black is the only available color.

**Mode:** Select a position where the ID information is most likely to be detected when the page is scanned. PrintID tracker information is embedded throughout the printed page, but the following options let you select a place to make it more visible, based on the white space of the document. Mode options include:

- **Fast:** Embeds data without verifying whether PrintID tracker information is likely to be detected. Select this option for documents with an average amount of white space.
- **Upper right:** Makes the PrintID tracker pattern more visible in the white space near the upper right corner of the page.
- **Presentation:** Scales the document data down, and prints it starting at the upper left edge of the page so that the PrintID tracker pattern is more visible in the white space created at the bottom of the page.
- **Verify:** The driver searches the document to determine whether PrintID tracker information is likely to be detected:
  - With a high likelihood, printing proceeds.
  - With a low likelihood, the user is prompted to print in Fast mode or cancel the job.

In Device Settings, PDL, select **GDI compatible mode** to make **Verify** available.

### Lock PrintID Tracker

The administrator can lock PrintID tracker to prevent users from disabling it. It is locked by creating a password, and once created, it is then required to unlock the feature. The password must be different than the **Administrator Settings** password. So even if a user knows the Administrator Settings password, they would need to know the specific password for Lock PrintID Tracker to unlock and disable it. This gives the administrator the option of ensuring that all print jobs have the tracking information that is embedded by the PrintID tracker feature.

When PrintID tracker is locked, Watermark and Security watermark are unavailable in the Security Settings dialog box. The options for PrintID tracker are also unavailable. The only available buttons are **Unlock**, **OK**, and **Cancel**. The **Unlock** button only appears if Lock PrintID Tracker is selected. The **Unlock** button gives the administrator a quick way to make changes to the PrintID tracker information without having to go to the Device Settings tab to unlock the feature. Clicking **Unlock** and entering the Lock PrintID Tracker password only temporarily unlocks the feature.
Once changes have been made and OK or Cancel is clicked, PrintID tracker is locked again.

To lock PrintID tracker:

1. In the **Device Settings** tab, click **Administrator** to open the **Administrator Settings** dialog box.
2. Select **Lock PrintID Tracker**.
3. Enter a 4-16 character password. Reenter the password in the **Confirm password** dialog box to confirm.
4. Click **OK** in all dialog boxes.

To unlock PrintID tracker:

1. In the **Device Settings** tab, click **Administrator** to open the **Administrator Settings** dialog box.
2. Clear **Lock PrintID Tracker**.
3. Type the established password.
4. Click **OK** in all dialog boxes.

To temporarily unlock PrintID tracker and change ID settings:

1. In the **Advanced** tab, click **Security Settings** to open the **Security Settings** dialog box.
2. Click **Unlock**.
3. Type the established password.
4. Add or edit an ID.
5. Click **OK** in all dialog boxes.

The selected ID is printed, and PrintID tracker remains locked.

**Enable Client Profile**

In a client/server environment, you can use profiles saved in the server or use client profiles created and saved in your driver. This feature is available in the Advanced tab only in a client/server environment.

- Clear the **Enable client profile** check box to select profiles from the server to apply to your print jobs. Server profiles are read-only.
- Select the **Enable client profile** check box to create and save custom profiles in your (client) driver.
EMF Spooling

When printing large documents, it can be beneficial to select **EMF spooling**. This delays spooling and returns the user to their application more quickly. EMF spooling is not available when KPDL is selected as the page description language (see *Page Description Language (PDL)* on page 2-5).
10 Profile

This feature lets you save printer driver settings as a profile. You can select multiple options in the Printing Preferences tabs, save them to a profile, and use all of them at once when you apply the profile. For example, you can save a profile with selected options for Print on both sides, landscape, and rear tray destination. Exported profiles can be shared with other KX Drivers on your computer or other computers. A maximum 26 profiles can be saved in one driver, including the default profile.

A set of common profiles can be installed as optional components from the Printer Installation Wizard.

**Note:** The Device Settings tab options cannot be saved to a profile.

Add Profile

Follow these steps to create a new profile.

1. Select the options you want in each Printing Preferences tab.

2. Click Profile.

3. Click Add to open the Add Profile dialog box.
Profile

4 Type a **Name** for the profile, select an **Icon**, and type an optional **Description**. The name can be up to 31 characters, the description can be up to 255 characters.

5 Click **OK** to save the profile.

6 Click **Apply** to activate the selected profile to the current print job.

**Note:** To reset the printer driver to default settings, select the **Factory Default** profile and click **Apply**. This clears the settings of a selected profile.

**Edit Profile**

Follow these steps to edit a profile.

1 Click **Profile** in the **Printing Preferences** dialog box.

2 Select a profile and click **Edit**.

3 The **Edit Profile** dialog box appears. You can edit the **Name**, **Icon**, or **Description**.

4 Click **OK** to save the profile.
Delete Profile

1 Click Profile in the Printing Preferences dialog box.

2 Select profiles and click Delete.

3 Click Yes to delete the profiles.

Import and Export Profile

You can export and save a profile on your computer and transfer it to other computers, then use it with other printing systems. Only one profile can be exported at a time. Use the import feature to import a profile.

Export

1 Click Profile in the Printing Preferences dialog box.

2 Select a profile and click Export.

3 The Export Profile dialog box appears. Name and save the profile.

Import

1 Click Import in the Profile dialog box. The Import Profile dialog box appears.

2 Select a profile and click Open.

3 The profile appears in the Select profile list.
Glossary

A

Access code  A four-digit code you must enter at the printing system’s operation panel to print a Private Print job. An access code can also be used with the Job storage feature.

Auto Configure  Device settings feature that queries a printing system through the network and automatically retrieves settings for optional devices, and memory. Driver settings will be updated with information received from the physical printing system. Installed devices will be displayed in the Preview image.

B

Booklet  Layout mode that prints a multi-page document in a booklet format by using a duplex unit. Two pages are printed on each side of a sheet to create a document that can be read like a book.

C

Cassette  Input paper tray.

Custom box  Job option that stores print jobs in the printing system’s memory for later printing from the operation panel. Custom box jobs are saved to boxes that are assigned to users, and can be restricted by password. Your printing system must have an installed hard disk to use this feature. 100 Custom boxes are set up on the printing system’s hard disk at installation. The maximum number of Custom boxes is 1000.

D

dpi  Dots per inch.

Duplex unit  Accessory that supports two-sided document printing.

E

EcoPrint  Printing mode that changes toner saturation, making the entire image, text and graphics, appear lighter in the printed job. The actual amount of toner used depends on the printing system mode and, the type of data printed (text, graphics, or both). EcoPrint does not increase print speed.

e-MPS  Job storage that lets you store print jobs in the standard Hard disk so that you can access and print the job again later from the printing system’s operation panel.

F

Fast printing  Printing mode that decreases spool size and increases print speed.

Finisher  Optional device for stapling, folding, punching, or sorting print jobs.

G

GDI compatible mode  A page description language option that accurately reproduces what is viewed on the screen using the Microsoft Graphical Device Interface (GDI) component to render the document. It generates data in a raster printing format, creating a larger printable file.

Gutter  Blank space on the left side or top of a printed page that can be increased by scaling down text and graphics. This supports stapling and hole punching. When used with Duplex printing, the enlarged blank space lines up evenly on both sides of the sheet. The larger blank space is created by shifting the printable area to the right or down as much as one inch (25.4 mm).
Job accounting  An accounting system that records and controls the number of pages printed by each account ID. Account IDs can be assigned at the printing system and stored in the driver. After account IDs are assigned, use Job accounting to print in the Copy Management mode.

KM-NET  Software that provides network-wide management of printers and copiers.

Kyocera image refinement  Imaging feature that smoothes the edges of text and vector graphics.

Mailbox  Print job destination option that distributes print jobs to output trays when an optional device such as a Sorter stacker, Document finisher, or Mailbox is installed.

Monochrome  Imaging mode that uses black toner only.

MP tray  Source tray used for labels, transparencies, envelopes, and custom printing media.

Offset jobs  Finishing mode that physically shifts each print job in the output tray. This feature requires an optional finishing device such as an Internal finisher or 1000-sheet finisher.

PDL  Page Description Language. This is the language used by your computer to tell the printing system how to print a document. Availability of some printing options depends on the selected PDL. Available page description languages are PCL XL, PCL 5e (monochrome models only), and KPDL.

Poster  Layout feature for printing a document in a larger size than the maximum supported by the printer so the cumulative sheets can be assembled as a poster. Use this feature to print a document in a large, eye-catching poster format, up to 25 times larger than the original document size.

PRESCRIBE  Kyocera's scripting language that you can use to embed commands into specified locations in a print job. See also Prologue/Epilogue.

Private print  Job feature that sends secure print jobs to the printing system with a four-digit Access code and stores them on the Hard disk. The job is printed out at the operation panel by using the Access code.

Profile  A set of user defined driver settings that you save as a group. After saved, you can select a profile by name and apply its settings to a print job without selecting each feature individually.

Prologue/Epilogue  Advanced feature that allows you to insert a macro into specific locations in the print job. An advanced user may choose to use this feature to embed a PRESCRIBE command that will call a macro to overlay PRESCRIBE form data or a graphic object, such as a logo or a signature, at a specific point in the print job.

Proof and hold  Job feature that prints one copy of a multiple copy job and then stores the remaining copies on Hard disk. After the first copy has been reviewed, the remaining copies can be printed or deleted at the printing system’s operation panel. Proof and hold jobs are stored temporarily and are deleted when the printing system is reset or powered off.
Quick copy  Job feature that prints all copies of a job, then saves the job on the printing system’s optional Hard disk temporarily for later access. The stored Quick copy jobs can be accessed from the printing system’s operation panel.

Resolution  The number of dots printed in one inch. Higher resolution improves the quality of detailed printed images.

Reverse page order  Print output option that sends a print job to a destination from the last page to the first. This option is unavailable when Printer default is selected.

Rotate copies  Finishing mode that draws every other copy from a separate tray and stacks them in a collated, multi-copy print job. The final stack clearly distinguishes each copy horizontally and vertically. For restrictions, see the Finishing chapter.

Separation  Finishing option that stacks print jobs in an output tray so that one print job or copy is clearly distinguished from another. Separation options include Offset jobs and Rotate copies.

Transparency  Clear sheet used as printing media.

Transparency interleaving  A Publishing feature that inserts a backing sheet between printed transparencies. The backing sheet, also known as an interleaf, helps keep transparencies clean and prevents the transparencies from clinging together.

User login  Registers users with a user name and password. User login provides job restriction by user, in contrast to the Job accounting feature, which assigns privileges by division or department. A maximum of 1000 login user names and passwords can be registered at the printing system. One hundred user names and passwords can be stored in the printer driver.

Watermark  Advanced feature that lets you add semitransparent text to a document.
Index

A
Accessing Printer Properties 2-1
Add Port Wizard 1-3
Add Printer Wizard 1-6
Administrator Settings 2-9
  job accounting 2-11
  password 2-12
Advanced tab 9-1
Assembly marks 4-5
Auto Configure 2-1
Available device fonts 6-4

B
Basic Printing Tasks 3-1
Binding 4-1
Bitmaps 6-3
Brightness 6-7

C
Cassettes 3-5
Client Profile 9-14, 9-17
Collate
to sort in their proper sequence 3-10
Collating Modes 3-8
Color
  adjustment settings 6-7
Command files 9-1
Common Profiles
  installing 1-5
Compatibility settings 2-12
Components, installing 1-5
Contrast 6-7
Cover
  printing 7-2
  printing options 7-2, 7-4
  printing with 7-1
Crop marks 4-5
Custom box 8-1 – 8-2, 8-6
  registering at the printer 8-3
  setting up in the driver 8-3

D
Data Passthrough 2-7
Device fonts 6-3
  disabling 6-4
Device Options 2-2
Document image, sizing 3-2
Document portability 6-5
Duplex Printing 3-6
Duplex unit 3-5

E
EcoPrint 6-2
EMF spooling 9-14, 9-18

F
Fast printing 6-5
Finisher 2-3
  Punch settings 2-3
Finishing 4-2, 5-1
Finishing Edge 5-1
Firewall 2-2
Font Substitution 6-4
Fonts 6-2
  native download 6-3
Found New Hardware Wizard 1-1

G
GDI compatible mode 2-6
Graphic Settings 6-4
Grayscale 6-7
Gutter 5-4
Gutters 5-4

H
Halftone Screen 6-6
Hard Disk Settings 8-4
Hole Punch 5-6
I
Imaging 6-1
Inserting a page 7-4
Installation 1-1
Installing Components 1-5
Installing Optional Devices 2-1
Inversion Options 6-5

J
Job Accounting 2-11
  administrator password 2-12
  password protect 2-12
Job Storage 8-2, 8-10
Jobs 8-1
  job storage 8-10
  private print 8-9
  proof and hold 8-8
  quick copy 8-7

K
KPDL 2-5, 6-5
  settings 2-6 – 2-7
Kyocera Image Refinement 6-2

L
Language Preference Selection 2-5
Layout 4-1
Left edge binding 4-1
License Agreement 1-1

M
Macros 9-1
Margins 5-4
Measurement 2-4
Media type 3-3
  available options 3-4
  combinations 7-6
  combined with Source 2-13
Memory 2-3
Mirror print 6-5
Monochrome printers 2-6
MP tray 3-5
Multiple pages per sheet 4-3

N
network cable 1-1
Non-Collating 3-10

O
Offset 5-7 – 5-8
Optimization 6-5
Optional devices, installing 2-1
Optional Printer Components
  installing 1-5

P
Page Description Language (PDL) Settings 2-5
Page Insert 7-4
Page Size 3-2
Paper Cassette 3-4
Paper Size matching 3-3
parallel cable 1-1
Pattern Scaling 6-5
PCL 2-5
  PCL 5e 2-5
    settings 2-6
  PCL XL 2-6, 3-3
    settings 2-7
PDF 2-6
  settings 2-7
PDL 2-5
  PDL settings 2-1, 2-5, 6-5
Plug-In Modules
  installing 1-5
Poster 4-3, 4-5
  assembly marks 4-5
  crop marks 4-5
  settings 4-5
  Sheets Per Page 4-4
  Sizes 4-4
PostScript 6-5
PRESCRIBE 9-1
Print borders 4-3
Print Quality 6-1
  Custom settings 6-2
Printer default settings 2-1
Printer Properties
  accessing 2-1
PrintID Tracker 9-14
  locking 9-16
Printing
   basic tasks 3-1
   covers 7-2
   duplex 3-6
   on paper of non-standard sizes 3-4
   remaining copies of proof and hold jobs 8-8
   reverse order 3-7
   with Custom Paper Sizes 3-6
Private Print 8-2, 8-9
Product Library CD 1-6
Profile 10-1
Prologue/Epilogue 9-1
Proof and Hold 8-2, 8-8
Punch
   positioning 5-6
   using 5-6
Punch Settings 2-3
Punch Unit 2-3

Q
Quick Copy 8-1, 8-7
   additional copies 8-8
   deleting 8-8

R
Recycled paper 3-2
Resolution 6-2
Reverse image 6-5
Reverse Order Printing 3-7
Right edge binding 4-2
Rotate Copies 5-7

S
Scaling 4-6
Security Settings 9-14
Security Watermark 9-7
   Security settings 9-14
Separation 5-7

Settings
   administrator 2-9
   Administrator password 2-12
   compatibility 2-12
   PDL 2-1, 2-5
   Punch 2-3
   user 2-4
Sorter Modes 3-9
Staple 5-4
Substitute with device fonts 6-3
System fonts 6-4

T
Transparency 3-2, 7-7
Transparency Interleaving 7-6 – 7-7

U
Unit of Measurement 2-4
USB 1-1 – 1-2
User login 2-9
User Settings 2-4
   Identification 2-4
   language preference 2-5
   measurement 2-4

V
Vista 1-2 – 1-3

W
Watermark 9-4
   add watermark 9-5
   additional text options 9-5
   delete watermark 9-7
   edit watermark 9-7
   page selection 9-4
Windows 2000 1-1
Windows Vista 1-2 – 1-3
Windows XP 1-1 – 1-3
Addresses

KYOCERA MITA EUROPE B.V.

Hacksteen 40, 2132 MS Hoofddorp
The Netherlands
Telephone: +31.20.654.000
Home page: http://www.kyoceramita-europe.com
Email: Info @ kyoceramita-europe.com

Kyocera Mita Nederland B.V.
Beechavenue 25, 1119RA Schiphol-Rijk
The Netherlands
Telephone: +31.20.58.77.200

Kyocera Mita (UK) LTD
8 Beacontree Plaza
Gillette Way Reading Berks RG2 0BS
U.K.
Telephone: +44.1189.311.500

Kyocera Mita Italia S.p.A.
Via G. Verdi, 89/91, 20063 Cernusco s/N
Milano, Italy
Telephone: +39.02.92179.1

Kyocera Mita Belgium N.V.
Sint-Martinusweg 199-201, 1930 Zaventem
Belgium
Telephone: +32.2.720.9270

Kyocera Mita France S.A.
Parc Les Algorithmes Saint Aubin
91194 GIF-SUR-YVETTE
France
Telephone: +33.1.6985.2600

Kyocera Mita Espana S.A.
Edificio Kyocera, Avda de Manacor No. 2
28290 Las Matas (Madrid)
Spain
Telephone: +34.91.631.8392

Kyocera Mita Finland OY
Kirvesmiehenkatu 4, 00880 Helsinki
Finland
Telephone: +358.9.4780.5200

Kyocera Mita (Schweiz)
Hohlstrasse 614, 8048 Zurich
Switzerland
Telephone: +41.1.908.4949

Kyocera Mita Deutschland GMBH
Otto-Hahn-Str., 12 D-40670 Meerbusch
Germany
Telephone: +49.2159.918.0

Kyocera Mita GMBH Austria
Eduard-Kittenberger-Gasse 95,
1230 Wien
Austria
Telephone: +43.1.86338.210

Kyocera Mita Svenska AB
Esbogatan 16B 164 75 Kista
Sweden
Telephone: +46.8.546.55000

Kyocera Mita Norge
Postboks 150 Oppsal, NO 0619 Oslo
Olaf Helsetsvel 6, NO 0694 Oslo,
Norway
Telephone: +47.22.62.73.00

Kyocera Mita Danmark A/S
Ejby Industrivej 1, DK-200 Glostrup
Denmark
Telephone: +45.5687.1100

Kyocera Mita Portugal, IDA.
Rua do Centro Cultural, 41 (Alvalade) 1700-106
Lisbon,
Portugal
Telephone: +351.21.842.9100

Kyocera Mita South Africa (PTY) LTD.
527 Kyalami Bouelvard
Kyalami Business Park Midrand
South Africa
Telephone: +27.(0) 11.540.2600

KYOCERA MITA AMERICA, INC.

Headquarters:
225 Sand Road
Fairfield, New Jersey 07004-0008
Telephone: (973) 808.8444
Fax: (973) 882.6000

Kyocera Mita Singapore PTE, LTD.
121 Genting Lane, 3rd Level
Singapore 349572
Telephone: 67418733
Western region:
14101 Alton Parkway
Irvine, CA 92618-7006
Telephone: (949) 457.9000
Fax: (949) 457.9119

KYOCERA MITA CANADA, LTD.

6120 Kestrel Road, Mississauga,
Ontario L5T 1S8, Canada
Telephone: (905) 670.4425
Fax: (905) 670.8116

KYOCERA MITA AMERICA MEXICO, S.A. DE C.V.

Av. 16 de Septiembre #407
Col. Santa Ines
Azcapotzalco Mexico,
D.F. 02130, Mexico
Telephone: (55) 5383.2741
Fax: (55) 5383.7804